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Welcome and Participant Information 
As a CONNECTIONS user, you are contributing to New York State’s child welfare data 
management system. Timely record keeping and documentation is an essential part of 
maintaining an accurate and reliable database. This guide is meant to provide detailed 
instructions for updating or correcting information contained in CONNECTIONS in a timely 
manner. 

The Content of this Guide 
This guide contains step-by-step instructions for accomplishing necessary updates or changes 
in CONNECTIONS, introductory remarks that provide a casework context for these tasks, and 
hints on how to carry out these tasks efficiently and effectively.  
 

  

Note: 
Any visible identifying data 
in this guide is simulated. 

Features of this Guide 
Two features of this guide help you quickly identify the information you need: 

• Tips, set apart in margin boxes, provide information to help you carry out 
CONNECTIONS tasks efficiently and effectively. Icons in the boxes help focus your 
attention on two kinds of tips: 

Helpful hints 

Things to watch out for 
 

• Subdivided Instructions: The step-by-step instructions for each procedure are 
subdivided into major sub-steps to make it easier to jump ahead to the correct step if 
you’re already on the window you need to access. After the initial instructions on how to 
sign on to the system and access CONNECTIONS, step-by-step instructions assume 
you have accessed the CONNECTIONS Toolbar.  

We hope you find this to be a useful aid in your work! 
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Logging On to Your PC 

Only designated individuals on computers that are set up to run the application can access the 
CONNECTIONS application. This section addresses the procedures for logging on to the 
Windows 2000 operating system.  

Once you have completed logging on to Windows, the step-by-step instructions in the next 
section will show you how to access CONNECTIONS. 

 

Step-by-Step: 
Logging On to Your Computer 

1 Press the Ctrl + Alt + Delete keys on your keyboard at the same time. 
A Confidentiality warning displays. 

2 Click on the OK button in response to the Confidentiality warning. 
The Log On window displays. Make sure that your user name and domain are listed 
correctly in the log on dialog box.  

3 Enter your password and click on the OK button. 
Your local desktop displays. 

Accessing CONNECTIONS 
The CONNECTIONS application is made available to users in three different ways: 

Production 
Database 

The Production Database contains “live” data. This is the 
database that all workers use to record information in 
CONNECTIONS. 

Training Database The Training Database contains simulated data and allows you 
to practice functions necessary for your casework activities. It 
mirrors the functionality of the Production Database. The Training 
Database is used only for instructor-led training classes. 

Preview Application The Preview Application contains a “snapshot” of actual case 
data. Information entered into the Preview application does not 
carry over to the Production Database. 

The Preview Application provides the opportunity to preview 
changes and enhancements planned for the CONNECTIONS 
system. The Preview Application is available for a limited time 
when changes to the system are made. You will receive special 
notice when the Preview application becomes available. 

To distinguish between the Training Database and the Preview application, keep in mind that 
the Training Database contains simulated data, while the Preview application is a “snapshot” of 
actual case data. The Training Database allows you to practice functions necessary for your 
casework activities. 
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Using the CONNECTIONS Production Database, you can access your Assigned Workload from 
any CONNECTIONS workstation throughout New York State. All you need is a valid User ID 
and password to gain access to your workload. 

Your access to information in CONNECTIONS is restricted to what is necessary for the normal 
performance of your job responsibilities; this is accomplished by the assignment of a unique 
User ID to each worker. The User ID and Password are the “keys” to access certain agency 
information. A worker’s User ID and password are also a form of identification; they link a 
worker to actions in the system. Workers are responsible for actions taken with their User ID 
and password. 

All workers in your agency must follow password standards established by OCFS/OFT. The 
following automated system controls support the password standards: 

• A password cannot be the same as the User ID. 
• Password length must be a minimum of eight (8) characters. 
• Maximum password age is 90 days. 
• After six (6) failed attempts, the system will lock the worker out of CONNECTIONS. 
• If a worker is locked out of the system based on password lock-out, the Security 

Coordinator must reset the password in order to permit that worker access to the 
system. 

In addition to the above controls, after 15 minutes of inactivity while logged into 
CONNECTIONS, the system locks the worker out. The worker must enter his/her password in 
order to log back in to the system. 

It is up to you to protect your password in order to prevent unauthorized access or misuse of 
information. Here are some ways to keep your password protected: 

• Make it difficult 
Select a password that is easy for you to remember, but difficult for others to guess. 
Don’t be stingy—make your password as long as possible (at least 8 characters and up 
to a maximum of 13 characters), in order to help reduce the likelihood of allowing 
someone to guess it. You cannot use all or part of your logon ID in your password, nor 
can you reuse any of your last 13 passwords. 

• Mix it up 
Your OCFS password must contain at least one uppercase letter, one lowercase letter 
and one number. CONNECTIONS users must never use symbols in their passwords. 

• Keep it to yourself 
Don’t share your password with others. Never display your password; if you need to 
write it down, don’t keep the information at your desk or anywhere it may be easily seen 
by others. 

• Embrace change 
You must change your password periodically—at least once every 90 days. If you think 
your password has been compromised, change it immediately. (Don’t forget to report the 
situation to your LAN/Security Administrator as soon as possible!) 

• Be yourself 
Use only your logon ID and password; never use a current or former co-worker’s ID or 
password. 
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If the AutoComplete window 
displays during the logon process, 

select the Don’t offer to remember 
any more passwords check box 

and click on the No button. 
 

CONNECTIONS resides on a centralized Citrix server. The Connections and other Citrix 
Applications icon on your local desktop opens the Connections and other Citrix Applications 
window, which contains icons of CONNECTIONS applications that are available to you based 
on your NT logon. When you double-click on one of these icons, your computer accesses the 
Citrix server and begins a “Citrix session.” The Citrix desktop displays, covering your local 
desktop and remaining open for the length of your Citrix session. The Citrix desktop also has an 
easily recognizable background. 

The CONNECTIONS icon displays on the Citrix desktop. Double-clicking the icon starts the 
application, opening a window on your desktop for it. The CONNECTIONS icon varies slightly, 
depending on the logon information you use (i.e., based on whether you opened a Citrix session 
for the Production Database, Training Database or Preview Application). 

When you log on to Citrix via the Connections Desktop 95 Percent icon, three icons display 
on the Citrix desktop: 

• Connections 
• CINPID (Data Warehouse; limited to designated users) 
• Policy Library 

The Task Bar at the bottom of the Citrix desktop provides a method of organizing the application 
windows that you have open in Citrix. You can have more than one application window open on 
your desktop at a time. Minimize a window by clicking on the Minimize button ( ). The 
minimized application window displays as a button on the Task Bar. This makes room for other 
windows you need to use at that moment. To re-open an application window, click on its button 
on the Task Bar; the application window displays as the active window, placing it “on top of” any 
other open windows. 

Clicking on the Start button (in the lower left corner of the Citrix desktop) displays the Start 
menu, which provides access to the Citrix Log Off procedure (see page 6 for details on this 
procedure). 
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Step-by-Step: 
Launching CONNECTIONS (Production) 

 
If you are logged on to the 
system, always lock your 

computer when you leave your 
desk. This will help prevent 

unauthorized individuals from 
using your User ID and 

password to access 
CONNECTIONS.  

You can lock your computer by 
holding down the Ctrl+Alt+Del 

keys at the same time and 
clicking on the Lock Computer 

button. 

1 From your local desktop, double-click the 
Connections and other Citrix Applications icon. 
The Connections and other Citrix Applications 
window displays, containing icons of applications that 
are available to you based on your NT logon. 

2 Double-click the Connections Desktop 95 Percent 
icon.  
A Confidentiality Warning message displays. 

3 Click on the OK button in response to the 
Confidentiality Warning. 
The Citrix desktop displays and your Citrix session 
begins. 

4 Double-click the Connections icon. 
When the CONNECTIONS Production Database has launched successfully, the 
CONNECTIONS Toolbar displays, reading: Production – CONNECTIONS Toolbar – 
<Your Name>. 

 

Step-by-Step: 
Launching CONNECTIONS (Preview Application) 

1 From your local desktop, double-click the Connections and other Citrix 
Applications icon. 
The Connections and other Citrix Applications window displays, containing icons of 
applications that are available to you based on your NT logon. 

2 Double-click the Connections Preview icon. 
A Confidentiality Warning message displays. 

3 Click on the OK button in response to the Confidentiality Warning. 
The Citrix desktop displays and your Citrix session begins. 

4 Double-click the Connections Preview icon. 
When the CONNECTIONS Preview Application has launched successfully, the 
CONNECTIONS Toolbar displays. The title bar reads: Preview – CONNECTIONS 
Toolbar – <Your Name>. 
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Closing CONNECTIONS and Logging Off Your PC 
When you have finished your work in CONNECTIONS, you should close both CONNECTIONS 
and your Citrix session. This is best done as a two-step process: first close CONNECTIONS, 
then log off of Citrix. Doing so (as opposed to logging off of Citrix while CONNECTIONS is still 
open) reduces the likelihood of problems occurring during the log off procedure. 

At the end of your workday, it is important to log off your PC; if you completely shut down (turn 
off) your computer, it will not be able to receive any updates that may occur overnight. Leaving 
the computer logged off (but with the power still on) will enable it to receive these updates. 

 

 

Step-by-Step: 
Closing CONNECTIONS and Logging Off Your PC 

1 Click on the File menu (represented by the Globe icon [ ] in the upper left corner 
of the CONNECTIONS Toolbar) and select the Close command. 

2 Click on the Start button in the lower left corner of the Citrix desktop and select Log 
Off <User name> from the resulting menu. 
The following message displays: 
“Are you sure you want to log off?” 

3 Click on the Yes button. 
This does not log off your machine; it only ends your session with the Citrix server. 
Your local desktop displays. 

4 Close all applications still open on your local desktop. 

5 Click on the Start button and select the Shut down… command from the resulting 
menu. 
The Shut Down Windows dialog box displays. Click on the drop-down arrow and 
select Log off <user name>, if it is not already selected. 

6 Click on the OK button. 
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CONNECTIONS Security 
In order to protect the confidentiality and integrity of case data, 
access to information in CONNECTIONS is carefully controlled. 
A number of factors determine the information you can view or 
maintain in CONNECTIONS, including your job function, the 
cases to which you are assigned, your assigned role and your 
Business Function Profile (BFP). 

 
The information you are able to 
view and the tasks you are able 

to perform in the Training 
Database may not mirror what 

you are able to do in the 
Production Database. Contact 
your supervisor and/or Security 

Coordinator if you have 
questions regarding your 

security access. 

Your agency’s Security Coordinator is responsible for ensuring 
that appropriate physical, logical and procedural controls (such 
as locking your keyboard when you are away from your 
computer) are in place to preserve the security properties of 
confidentiality, integrity, availability and privacy of 
CONNECTIONS information. Information must be protected 
and classified based on security best practices as defined in 
the International Security Standard ISO/IEC 17799, A Code of 
Practice for Information Security Management. 

An agency may find it necessary to allow workers to complete their job functions outside of the 
office. When working from a remote location, the following security controls need to be 
considered and are not limited to: 

• the existing physical security of the remote location; 

• the communication security requirements; 

• the sensitivity of the information that will be accessed and transmitted; and 

• the threat of unauthorized access. 

Confidential information should not be stored on (nor transmitted from/to) portable computer 
devices. If workers must store or transmit confidential information, protective measures must be 
implemented. When using mobile commuting devices such as laptop computers, Personal 
Digital Assistants (PDAs) and cellular phones, special care should be taken to ensure that 
confidential information is not compromised. 

When traveling, CONNECTIONS staff using portable computers should not check these items in 
airline luggage systems. Confidential information should be removed prior to traveling; removing 
confidential information from portable computers should be done on a regular basis.  

Dial-up modems should not be connected to computer systems that are on a LAN or another 
internal communication system, unless approved by OCFS. Also, no wireless network or 
wireless access point should be installed without performing a risk assessment and obtaining 
appropriate written approval from the OCFS Information Security Officer. 

Software should never be installed without the approval of the OCFS Information Security 
Officer. Software security patches are installed by OFT. Computers should be left turned on (but 
logged off) so that security patches can be installed when users are not using their computers.  

Anti-virus software will protect against the vast majority of viruses and other vulnerabilities, but 
it’s not foolproof. Everyone has a responsibility to ensure that proper precautions are taken to 
protect the network and to ensure that viruses don’t get in or get spread. 
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There are also some security issues to keep in mind when contacting individuals, whether it is 
by telephone, cellular phone, fax or e-mail. 

Avoid using Internet, third party or wireless fax services to send or receive faxes containing 
confidential information. If it is necessary to send confidential information via fax, be sure to 
verify the phone number prior to sending the fax and contact the recipient to ensure the fax is 
picked up immediately. Also, avoid sending teleconference call-in numbers and passwords to a 
pager if sensitive information will be discussed in the conference; confirm that all participants 
are authorized to participate prior to starting any discussion.  

Precautions also need to be taken when exchanging information over the telephone. Take care 
that you are not overheard when discussing confidential matters on the telephone. You should 
avoid leaving sensitive or confidential messages on voicemail systems. Take extra precautions 
when using mobile devices in public areas outside of the workplace. Any use of wireless or 
cellular phones should be avoided when discussing sensitive or confidential information. 

Do not exchange confidential information over a messaging system unless authorized by the 
OCFS Information Security Officer, after a formal risk assessment of the situation has been 
performed. No external public Instant Messaging, Teamrooms and Conferencing services 
should be used to conduct business unless authorized in writing by the OCFS Information 
Security Officer. 

Your Security Coordinator may need to monitor workers’ activity on the system, since it is the 
Security Coordinator’s responsibility to ensure that all security processes and procedures are 
followed. Do not have any expectation of privacy in the information stored in or sent through the 
OCFS network, including e-mail, because your Security Coordinator and OCFS/OFT reserve 
the right to monitor or search any system at all times. You are notified of this each time you log 
on to the network (a privacy message displays). 

As a CONNECTIONS user you must understand your role and responsibility regarding the 
security of CONNECTIONS information. You have an obligation to protect and preserve all 
information in a consistent and reliable manner. 

All CONNECTIONS users receive security profiles which determine the windows or types of 
information they can open and view, as well as which windows they can modify or “maintain.” In 
CONNECTIONS, each person’s security profile is called a Business Function Profile (BFP). 
Each worker has only one BFP. Each BFP is comprised of one or more Business Functions, 
which in turn are comprised of one or more Security Attributes. Your BFP is based on the tasks 
you are responsible for performing and the level of access to records needed to complete those 
tasks. Your BFP may include multiple business functions based on your responsibilities. 

Security coordinators at the local district and voluntary agency level assign appropriate 
Business Functions to each staff person in their offices, creating an individual Business 
Function Profile for each worker. A few examples of Business Functions that might be included 
in a local district worker’s Business Function Profile are CREATE FSI, ENTER PROG NOTE 
and CASE/PERS SRCH. Workers with the UNIT SUM ACCESS Business Function in their 
respective BFPs are able to review the Assigned Workloads of the staff members in their units. 
(Typically, this Business Function would be included in the BFP of a Unit Approver.) 

If you are working on a stage and cannot view or modify information that relates to your job 
responsibilities, you should review your BFP with your supervisor to make sure the Business 
Functions included in your BFP are adequate for the work you are doing. CONNECTIONS users 
are not allowed to prove a suspected weakness; in other words, workers should not attempt to 
find work-arounds or bugs in the system. All CONNECTIONS users should be aware of the 
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procedure for reporting security incidents that may have an impact on the security of 
information. You must report any incidents to your appropriate supervisor and your agency’s 
Security Coordinator.  

A special Business Function, VIEW SECURITY, allows you to review your BFP in 
CONNECTIONS to see the business functions assigned to you. If your BFP indicates that you 
do not have security access for a task you need to complete, speak with your supervisor and/or 
Security Coordinator. 

 

Step-by-Step: 
Viewing Your Business Function Profile 

1 Click on the Options menu on the CONNECTIONS Toolbar and select the Security 
command. 
The Security sub-menu displays. 

2 Click on the View Staff Security command. 
The Staff Search Criteria window displays. 

3 Type your last name into the Last Name field. 

4 Click on the Search button. 
The Staff List displays. 

5 Click on your name to select it from the Staff List. 

6 Click on the OK button. 
The Staff Security window displays. The Business Functions field on this window 
contains the available Business Functions. 

7 The Business Functions assigned to you are identified with red check marks. Use 
the vertical scroll bar inside the Business Functions field to view the entire list. 
To see the Business Functions assigned to you without scrolling through the entire 
list, click on the Selected Business Functions Only check box. 

8 To close the Staff Security window, click on the Cancel button. 
The CONNECTIONS Toolbar displays. 
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Module 1: 
Person Maintenance 

As you gather information about people associated with a case, you may obtain new information 
or information that needs to be corrected. The Stage Composition tab on Family Services 
Stages in CONNECTIONS provides access to a number of windows where you can record this 
information. Local districts, Voluntary Agencies, New York State offices and other agencies rely 
on CONNECTIONS users to record all relevant information gathered, so that others can make 
use of that information in the future. 

In this module you will learn how to add and correct the information on persons associated with 
a case. 

By the end of this module, you will be able to: 

• add and relate people to the FSS; 

• maintain primary address and phone information; 

• add and correct person identifiers; 

• maintain relationships within the FSS; 

• add and modify Program Choices; 

• add and modify Permanency Planning Goals; 

• associate and unassociate workers; 

• maintain Primary and Secondary Caretakers; 

• merge and split person records in the database; 

• end-date a person’s involvement in the FSS; and 

• maintain information about freed children. 
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Maintaining Information About People in a 
Family Services Stage 
During the timeframe in which a Family Services Stage (FSS) is open, the composition of the 
household may change. For example, spouses may divorce and/or re-marry, step-children may 
become part of the household, biological children may be born, older children may reach the 
age of maturity and leave the household, or extended family members may be associated with 
the stage. As information changes about one or more individuals, or about the family as a 
whole, it is important for assigned workers to keep the information up-to-date in the electronic 
case record. 

The Stage Composition tab on the Family Services Stage window allows you to add to or 
modify the composition of the Family Services Stage, including person demographics, person 
identifiers, address and phone information for all persons already associated with the stage. In 
addition, you can do the following from this tab: 

• Add and relate people to the FSS 

• Maintain address and phone information 

• Select Primary/Secondary Caretakers 

• Maintain Primary Address information for multiple persons 

• End-date stage involvement of persons in the stage 

• View the Historical Stage Composition 

• View and/or maintain the Family Relationship Matrix 

• Change the Final Adoptive Name (CCR stage only) 

• View Family of Origin information (CCR stage only) 

In order to view and/or maintain information on the Stage Composition tab, you must have a 
role in the stage (i.e., Case Manager, Case Planner, Caseworker, CPS Worker/Monitor). If you 
previously had (but no longer have) a role in the FSS stage, you can view current and historical 
information until the point at which you ceased having a role in the stage. 

Aside from your assigned role in an FSS, you can also access the FSS in any of the following 
circumstances: 

• If you have an historical role in a CPS Intake (INT), CPS Investigation (INV), or 
Administrative Review (ARI) stage that is currently closed, you can view all of the FSS 
stages associated with the case that existed before your assignment ended. 

• If your district or agency has established Agency Access that permits view-only or 
maintain access to FSS stages, you can access those stages until Agency Access is 
changed to remove such access. 

• If you have been assigned the ACCESS ALL DIST (Access All in District) or ACCESS 
ALL AGY (Access All in Agency) Business Function, you can view all of the FSS stages 
in your district or agency. 
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• If you have an Implied role in the FSS (because you have a role in a separate case that 
shares a person in common with the FSS), you can view all of the information for the 
case in which you have an Implied role. If you are a Voluntary Agency worker, you will 
not be able to access information in CPS Intake or Investigation stages. 

• If you are in the unit hierarchy of a worker who has a role in the case and you have been 
assigned the UNIT SUM ACCESS Business Function, you can access the FSS from that 
worker’s Assigned Workload. 

 

The Stage Composition tab can be accessed in view-only mode via the Event List for a 
specific FSS. To open the tab in modify mode, you must access it via the Assigned Workload. 
Whenever you access the FSS in this manner, the Stage Composition tab is the first tab 
displayed (“home” tab). 

 

Step-by-Step: 
Accessing the Stage Composition Tab 

1 From the Assigned Workload, select the appropriate FSS stage. 
The Tasks… button enables. 

2 Click on the Tasks… button. 
The Family Services Stage displays with the Stage Composition tab active. 
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Maintaining Person Demographics 
The Person List grid on the Stage Composition tab contains the following columns of 
information for each person associated with the stage: 

First Name 
Last Name 
Middle Name 

 The person’s full name 

Suffix  The person’s suffix (e.g., Junior, Senior, PhD, etc.), if any 
Person ID The person’s unique, CONNECTIONS system-generated 

identification number 
M/S “Y” in this column denotes that the person’s record was 

involved in a merge (to combine two person records) or a split 
(to separate erroneously combined person records). 

Sch The Person Search indicator: “V” in this column denotes that 
the Person Search results were viewed (but not related); “R” 
denotes that the person was related to the FSS. 

DOB The person’s date of birth 
Approx (DOB) The Approximate Date of Birth column displays “Yes” or “No” 

to indicate whether the DOB displayed is approximate, not 
exact.  

Age The person’s age (typically calculated from the DOB; may be 
recorded directly, which automatically updates the DOB field) 

PC/SC The Primary/Secondary Caretaker indicator; denotes that the 
individual has been selected as either the Primary Caretaker 
or Secondary Caretaker of the child(ren) in the stage. 

Marital The person’s marital status 
Sex The person’s sex 
Ethnicity The person’s ethnicity  
Race The person’s race; displays “Multiple” if more than one race is 

selected 
Language The person’s language; only one language may be selected, 

however, “Multiple” is an available option 
Religion The person’s religion  
DOD The person’s date of death, if applicable 
Approx (DOD) The Approximate Date of Death column displays “Yes” or “No” 

to indicate whether the DOD displayed is approximate, not 
exact. 

Reason The reason for the person’s death (e.g., Accidental, Drug 
Related, Natural Causes); “A/N” indicates that the cause of 
death was related to abuse or neglect (in an open case, a 
closed case, or no prior case) 
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Phone and 
Extension (Extn) 

The person’s primary phone number and extension, if any 

Type The type of phone number listed in the Phone Number field 
(e.g., Residence) 

Date Added The date the person was added to the Family Services Stage 
(If the person was associated with the stage at the time the 
FSS was progressed from the FSI, the FSS stage creation 
date displays here.) 

In order to see all of these columns, you need to use the horizontal scroll bar at the bottom of 
the Person List grid. When you scroll to the right, the name fields will “lock”; they display 
constantly regardless of what other columns you view. An asterisk (*) preceding a field’s name 
on the window denotes information required by the Adoption and Foster Care Analysis and 
Recording System (AFCARS) or the National Child Abuse and Neglect Data System (NCANDS) 
This is data that New York and all other states must provide to the Federal government. 

The following fields can be modified within the Person List grid: 
• Last Name • Sex 

 
The Age field updates 

automatically when the DOB 
field is modified. 

• First Name • Language 
• Middle Name • Religion 
• Suffix • DOD 
• DOB • Approx 
• Approx • Reason 
• Marital  

Information can be typed directly into the Last Name, First Name, Middle Name, DOB and 
DOD fields. For the other fields above, click in the cell to display a drop-down arrow, then click 
on that drop-down arrow and select from the resulting list. Click on the Save button to save any 
changes you have made. 

 

The following fields are system-generated and cannot be 
modified: 

• Person ID • PC/SC 
The information that displays in 

the PC/SC field changes if 
Primary and Secondary 

Caretaker designations are 
modified (see “Maintaining 

Caretaker Information” on page 
58 for information on recording 

and modifying Primary and 
Secondary Caretakers). 

• M/S • Date Added 
 • Sch 

The information that displays in the Phone, Extn and Type 
fields changes when phone number information is modified 
using the Maintain Phone window or Maintain Primary Address 
and Phone window (see “Maintaining Address and Phone 
Information” on page 26 for more information on maintaining 
phone numbers). 
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The Ethnicity and Race fields can be modified using the Ethnicity and Race sections that 
display below the Person List grid. 

 

Step-by-Step: 
Maintaining Ethnicity Information on the Stage Composition Tab 

1 From the Person List, select the person whose ethnicity you need to record/modify. 

2 Using the drop-down arrow in the Ethnicity section below the Person List, select HL 
(Hispanic or Latino) or NH (Non-Hispanic or Latino). 
If you selected HL, the section below enables; proceed to Step 3. 
 

—OR— 
 

If you selected NH, the section below is disabled; skip to Step 4. 

3 Click on the appropriate check box(es) to select the Hispanic or Latino origins. 

4 Click on the Save button. 
The information is saved and displays in the Person List grid. 

 

Step-by-Step: 
Maintaining Race Information on the Stage Composition Tab 

1 From the Person List, select the person whose race you need to record/modify. 

2 In the Race section below the Person List, click on the appropriate check box(es). 
The Save button enables. 

3 Click on the Save button. 
The information is saved and displays in the Person List grid. 
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Adding or Relating a Person to the FSS 
When you click on the Add/Relate button to add or relate a person to a Family Services Stage, 
the Add/Relate Person window displays. From this window, CONNECTIONS automatically 
requires you to conduct a Person Search to determine whether or not that individual is already 
known to the CONNECTIONS database. 

If, after conducting a thorough Person Search, you determine that an individual is not known to 
the CONNECTIONS database and you need to add that person to the FSS (see “Adding a 
Person to a Family Services Stage” on page 22 for more information); the Add/Relate 
functionality allows you to add the individual to CONNECTIONS and establish a unique, system-
generated Person ID (PID) for that individual. If you determine that the person is already known 
to CONNECTIONS, you need to relate that individual’s existing person record to the FSS. (See 
“Person Relate” on page 23 for more information.) 

The process of conducting a thorough Person Search helps you avoid creating duplicate person 
records. This affects not only system data integrity but, more importantly, the accuracy, currency 
and completeness of a person’s historical record in the system. It is imperative that child welfare 
workers have as much complete, accurate and current information as possible when making 
decisions that affect children and families. The CONNECTIONS system is dependent on the 
accuracy of case data in order to present accurate information about the family. 

The Add/Relate Person Window 
The Add/Relate Person window is divided into three sections: 

• Search fields 
• Person Search List 
• Buttons 
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The search fields provide a variety of informational categories for conducting and refining a 
Person Search. The following search fields are available on this 
window: 

Search Type You can conduct a Person 
Search for individuals in 
CONNECTIONS using different 
Search Types: 

 

• Phonetic Name 
• Phonetic Address 
• Exact 

The Search Type defaults to 
“Phonetic Name.” 

 A Phonetic Name Person Search returns matches that sound 
similar to the search criteria; this usually produces the largest 
pool of results. You can use Phonetic Name search even if the 
name you are searching for may not be spelled correctly. 

Phonetic Address Person Search returns results that sound 
similar to the information entered in the Address section. 

Required fields on the Person 
Search window highlight in 
yellow when the associated 

Search Type is selected. Fields 
that are not available for a 

particular Search Type disable 
when that type is selected. 

An Exact Person Search returns results that match the search 
criteria character for character and space for space. This type of 
search is typically used with Person ID numbers or Client 
Identification Numbers (CINs). 

To change the search type, click on the drop-down arrow for the 
Search Type field and select from the resulting list. 

First, Middle, Last 
name You can use one or more of these fields (when enabled; see the 

tip box on this page) to enter search criteria. Keep in mind that 
the broader you make your search criteria, the more likely you 
are to find a potential match in CONNECTIONS. 

For detailed information about these fields or the detailed 
Person Search process, see the Search Techniques Step-by-
Step Guide, which is available on the OCFS CONNECTIONS 
intranet site. 

Address 
Information 
DOB 

 Age 
Race 
Sex 
Phone 
Identifiers section 

The Person Search List displays the results of the search. The columns in the Person Search 
List contain the same information for which you can search via the search fields in the upper 
half of the window. Not all of the fields in the search section are included as columns in the 
Person Search List. Names that have been marked as “Invalid” will not return in a Person 
Search. 
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The Person Search List includes the following columns, which are not included in the search 
fields: 

Match Name This is the name of an individual who is recorded in 
CONNECTIONS. The Match Name can be a Primary name or an 
end-dated name. 

This is the Primary name of an individual who is recorded in 
CONNECTIONS. Only names that have been recorded as “Primary” 
display in this column. 

Primary Name 

This column denotes the type of Person Search that was conducted 
(and for which search results display): 

Match 

• Phonetic Name Person Search: “NAME” 
• Phonetic Address Person Search: “ADDR” 
• Exact Person Search: “EXCT” 

Score This column indicates the relative accuracy of a particular search 
result (compared to the search criteria) on a scale of 0 to 100. The 
Score for an Exact Person Search will always be “100.” However, it 
is important to note that a result with a score of “100” is not 
necessarily a definite match; multiple results with a score of “100” 
may be returned. 

The following buttons display at the bottom of the Add/Relate Person window: 

Search This button activates the search, based on the search criteria. The 
button enables only when you have entered the minimally required 
search criteria (based on the Search Type you selected). 

This button opens the Case List, displaying all current and historical 
cases with which the selected person has been associated. 

Case List 

This button opens the Add Person window, displaying person 
information currently recorded for the individual in CONNECTIONS. 

Relate 

This button opens the Add Person window, where you record 
complete demographic information about the person you are adding 
to the FSS. (See “The Add Person Window” on page 21.) 

New 

Clear This button clears the search criteria fields, enabling you to enter 
new search criteria. 

This button closes the Add/Relate Person window, returning you to 
the Stage Composition tab. 

Cancel 

 

CONNECTIONS Step-by-Step Guide Page 19 
Data Maintenance for Family Services Stages  Version 1 (10/11/2005) 



 

Step-by-Step: 
Conducting a Person Search to Add or Relate a Person 

1 On the Stage Composition tab, click on the 
Add/Relate button. 
The Add/Relate Person window displays. 

2 In the First and Last name fields on the Add/Relate 
Person window, enter the name of the person for 
whom you are searching. 

3 Click on the Search button. 
The search results display in the Person Search List 
at the bottom of the Add/Relate Person window. If no 
matches are found, the following message displays 
in the Person Search List title bar: 
“No Results Returned.” 

Search results may include more than one possible match for your search criteria. Explore all 
possible matches. The individual you are searching for may be listed more than once in the 
database. Review the information in the Person Search List to determine if the person you are 
searching for matches one or more of the results on the list. Look at the demographics listed in 
the Person Search List to help you make this determination. If you don’t have enough 
information to determine whether or not you have found a proper match, you can access more 
information about a person in the Person Search List by looking at other cases with which that 
person has been involved. This process is sometimes called “drilling down.” 
 

 

Person Search defaults to the 
Phonetic Name Search Type. 
This usually produces the best 

pool of results. 

To conduct a Phonetic Address 
or Exact search, click on the 

drop-down arrow for the Search 
Type field and select from the 

resulting list. 
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The Add Person Window 
If you determine, after conducting a thorough Person Search, that the individual you are 
searching for is not known to the CONNECTIONS database, click on the New button at the 
bottom of the Add/Relate Person window to open the Add Person window where you can add or 
relate the person. Upon adding or relating a person to a Family Services Stage, that person is 
also added to the CONNECTIONS database. 

Use the Add Person window to record complete and accurate person demographic information. 
The following fields display on this window: 

Person Information Section 
• First, Middle, Last 

(system-populated based 
on search criteria;  
non-modifiable) 

• Marital 

• SSN 

• Language 

• Sfx (Suffix) • DOD 

• DOB • Approx DOD 

• Approx DOB • Reason (cause of person’s death) 

• Age 

• 
•
 
 Religion 

Sex 

x/Apt 

A Phone

Ad n dress Sectio

• Street • Zip 

• PO Bo • County 

• City • Type 

• State • CD 

 (Phone, Ext, Type) and Ethnicity section also display. 
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Step-by-Step: 
Adding a Person to a Family Services Stage 

 

1 On the Stage Composition tab, click on the 
Add/Relate button. (You can also click on the Options 
menu on the Stage Composition tab and select the 
Add/Relate command.) 
The Add/Relate Person window displays.  

When the Add Person window 
displays, the DOB field defaults 

to today’s date. 
To change this date: 

2 In the First and Last name fields, enter the name of 
the person you need to add to the FSS and click on the 
Search button.  
The search results display in the Person Search List  
at the bottom of the window. Review the search 
results carefully to determine whether any individual on 
the Person Search List is the same individual you need 
to add to the FSS. If so, you need to relate, not add, 
that person. (Stop here and proceed with “Relating a 
Person to a Family Services Stage” on page 24.) 

1 Click on the check box to the 
left of the date field to make 
the date “active.” 

2 Click in the Month, Day and 
Year segments of the field 
and change the dates, as 
appropriate. (The Month, Date 
and Year segments are 
independent of each other, so 
each needs to be changed 
individually.) 

—OR— 
1 Click on the drop-down arrow 

for the DOB field and select 
the correct date from the 
resulting calendar. Click on 
the Month heading and select 
the appropriate month from 
the resulting list. Finally, click 
on the Year heading, then 
click on the up and/or down 
arrow, as necessary, to select 
the appropriate year. 

3 If the person is not known to the CONNECTIONS 
database, click on the New button. 
The Add Person window displays. The name you 
entered in the search criteria displays automatically in 
the name fields; you cannot modify this information on 
this window. 

4 Record demographic information for the person in the 
detail section in the upper half of the window. 

5 Record the person’s address in the Address section, 
then click on the Validate button. 
See the tip box on page 25 for details about address 
validation. 
An address must be recorded. You can record 
“Unknown” in the Street and City fields, if necessary 
(e.g., if the person is homeless). The Save button will 
not enable until you have recorded an address. It is 
preferable to use the Agency address for the person 
if s/he is homeless. 

6 If the resulting address is correct, click on the Accept 
button to accept it. 
 

—OR— 
 

If the address is not correct, click on the Reject 
button and repeat Step 6.  

 

When a person is added to the 
FSS stage, CONNECTIONS 
sends an Alert To-Do to the 

Staff To-Do List of all workers 
assigned to the stage. 
The description of the 

Alert To-Do reads: 
“Name <PID> was added to 

Stage Name <Stage ID>” 
In addition, if the FASP is in 

process, the following message 
displays: 

“A new person has been added. 
The Relationship Matrix must 

be updated.” 
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7 Record the person’s phone information in the Phone 
section, including the Type. 

8 Click on the Save button. 
The Stage Composition tab displays. 

These changes may impact 
the WMS case information. 

Please refer to the WMS 
information in Module 4. Person Relate 

After you have conducted a thorough person search and 
verified that the individual you are searching for is known to the CONNECTIONS database, 
select that person from the Person Search List and click on the Relate button at the bottom of 
the Add/Relate Person window to open the Add Person window. 

To minimize the occurrence of misrelates when you attempt to relate two people in the system, 
CONNECTIONS generates warnings when you click on the Save button on the Add Person 
window, if any of the following conditions are present: 

• There is a DOB/age discrepancy of more than five years between the two persons. 
The following warning displays: 
“DOB varies by >5 years between Individuals. 
Do you wish to continue?” 

• There is a gender mismatch between the two persons. 
The following warning displays: 
“Sex Mismatch between Individuals. 
Do you wish to continue?” 

• The relationship/interest is Foster Parent (FP) for one person and not the other. 
The following warning displays: 
“Relating Individuals with a different Rel/Int. Do you wish to continue?” 

• There is a role mismatch between the two persons being related. 
The following warning displays: 
“Relating a FAD and CPS Individual. Do you wish to continue?” 

• There is a county mismatch between the two persons. 
The following warning displays: 
“Individuals do not reside in the same district. Do you wish to continue?” 

• If the system recognizes more than one condition, the following warning displays: 
“More than one relate mismatch. Do you wish to continue?” 

These warnings display to alert you of potential conflicts; you need to evaluate the information 
carefully and determine if it is appropriate to proceed with Relating the individual. These 
warnings do not prevent you from completing the Relate function. 
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Step-by-Step: 
Relating a Person to a Family Services Stage 

1 On the Stage Composition tab, click on the Add/Relate button. 
The Add/Relate Person window displays. The Search Type defaults to “Phonetic 
Name.” 

2 In the First name field, enter the first name of the person you need to add to the 
FSS. 

3 In the Last name field, enter the last name of the person you need to add to the 
FSS. 
The Search button enables. 

 
4 Click on the Search button. 

The search results display in the Person Search List 
at the bottom of the window. Review the search 
results carefully to determine whether any individual 
on the Person Search List is the same individual you 
need to add to the FSS. If not, you need to add, not 
relate, that person. (See “Adding a Person to a 
Family Services Stage” on page 22.) 

5 Select the person who is to be related to the FSS, 
then click on the Relate button. 
If all required demographic information has been 
recorded in CONNECTIONS for the person you are 
relating, the Stage Composition tab displays with 
the person added to the Person List. The person 
relate is complete. 
 

—OR— 
 

If all required demographic information has not been 
recorded, the Add Person window displays. Proceed to Step 6. 

When you relate a person to the 
FSS stage, CONNECTIONS 
sends an Alert To-Do to the 

Staff To-Do List of all workers 
assigned to the stage. 
The description of the 

Alert To-Do reads: 
“Name <PID> was related to 

Stage Name <Stage ID>” 

In addition, if the FASP is in 
process, the following message 

displays: 
“A new person has been added. 

The Relationship Matrix must 
be updated.” 

6 Complete any missing demographic information for the person in the detail section in 
the upper half of the window. 
Address and phone information cannot be modified until after the person is part of 
the Stage Composition. If the person’s address and 
phone information need to be modified, use the 
Maintain Primary Address and Phone window (see 
“The Maintain Primary Address and Phone Window” 
on page 31 for more information).  

These changes may impact 
the WMS case information. 

Please refer to the WMS 
information in Module 4. 

7 Click on the Save button. 
Warnings and/or error messages may display on the 
Add Person window. Warnings do not prevent the 
Person Relate from proceeding; error messages do. 
Be sure to verify the demographic information and 
address any warning messages that display. 
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Address Validation 

When you click on the Validate button, CONNECTIONS launches a 
search to verify the validity of the address and format it to comply with 

U.S. Postal Service standards. The address validation window displays, 
containing a side-by-side comparison of the address you recorded and 

the validated address in standardized postal format. Compare the 
address you recorded to the address provided. 

If the validated address is the same as or more complete than the 
address you recorded, click on the Accept button; otherwise, click on the 

Reject button. 

If a different address (or an address that is not as complete as the 
address you recorded) is returned and you are certain that the address 

information you recorded is correct, click on the Reject button. 

When an address cannot be validated, an error  
message displays: 

• If the house number is missing or invalid, the following  
message displays:  
”The house number is invalid.” 

• If the street name is misspelled or the street name is unable to be 
matched, the following message displays: 
”The street is invalid.” 

• If the city name is misspelled or the city name is unable to be 
matched, the following message displays: 
”The street is invalid.” 

If a message displays indicating that the address information you 
recorded is invalid (e.g., “The house number is invalid” or “The street is 

invalid”), click on the OK button to close the message. 
Be sure to verify that the address you recorded is correct. 

If it is not correct, record the correct address in the appropriate fields. 

All addresses must be run through the 
validation process in CONNECTIONS. 
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Maintaining Address and Phone Information 
The Maintain Address Window 
The Maintain Address window enables you to view and record 
multiple addresses for an individual. Address records are 
distinguished by type, such as residence, business and mailing. 
Each address also includes a start date and (if applicable) an 
end date, allowing you to view both current and historical 
address information. In addition, an address record can be 
designated as “Primary” or as “Invalid.” A Primary address is 
the address where the person physically lives and/or is most 
often found; an Invalid address is an address that was never 
correct. Only one valid Primary address can exist for a person 
at one time. When you add a new Primary address for a 
person, the old Primary address end-dates automatically. 

 

In order to maintain address information, the following must be true: 
• The Family Services Stage is open. 

—AND— 
• You have a role in the stage (or can access the Assigned Workload of a worker who 

has a role in the stage). 

 

Addresses should be 
invalidated only if they were 

never correct. 

Addresses that were correct but 
have changed are end-dated. 
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This window is arranged in two main sections: the detail section at the top of the window and 
the list section at the bottom of the window. The detail section contains the following fields: 

 

Record the address information in these fields. Type the information 
directly in the fields. For the State field, click on the drop-down arrow 
and select the appropriate state from the resulting list. 

Street 
PO Box/Apt 
City 
State 
ZIP 

 The system-generated Community District (CD) code displays only 
for New York City addresses. This field is populated by the validation 
process and cannot be modified. 

CD 

 Click on the drop-down arrow for this field and select the appropriate 
county from the resulting list. If you selected any state other than 
New York in the State field, the County field defaults to “Out of 
State” and disables. 

County 

 This field enables you to indicate whether the address is a residential 
address or another type of address (e.g., a business address). 

Type 

 Select this check box to indicate that the associated address is the 
primary address. The primary address is the location where the 
individual resides. 

Primary 

 Select this check box to indicate that the associated address was 
never correct. If the address was previously (but is no longer) 
correct, end-date the address; do not mark it as “Invalid.” 

Invalid 

The Type field is required for every address. Once an address has been recorded and saved, 
the type cannot be changed. For example, if you recorded and saved the person’s home 
address, inadvertently selecting Business in the Type field’s 
drop-down list, you must invalidate that address and record 
the address again (with the appropriate address type) in the 
detail section. 

The Start Date is the date on which the address was first 
recorded in the system. The End Date is the date on which 
the address is no longer applicable. When you invalidate an 
address, the End Date reflects the date when you invalidated 
the address; when you change the primary address, the End 
Date displays for the former primary address, indicating the 
date when the primary address change was recorded in 
CONNECTIONS. The Start Date and End Date fields are not modifiable; the Start Date is 
recorded automatically when you add an address, while the End Date field is recorded 
automatically when you record a new primary address or, for a previously saved address, when 
you click on the Set End Date button. 

 

When recording an address in 
CONNECTIONS, be sure to run 

the address through 
address validation. 

See the tip box on page 25. 

Newly added records, which have not been saved to or retrieved from the database, can be 
modified. Once any address field is changed, the Modify button enables. Address records that 
have been saved to and retrieved from the database can only be set to Invalid, be end-dated or 
have the Comments field modified. 
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Step-by-Step: 
Adding an Address 

1 On the Stage Composition tab, select the appropriate person from the Person List 
and click on the Address button.  
The Maintain Address window displays. 

2 Record the new address information in the Address Information section. 
The Validate button enables. 

3 Select the Primary check box to designate this address as the primary address, if 
applicable. 

4 Click on the Validate button. 
The address validation window displays. 

5 If the resulting address is correct, click on the Accept button to accept it. 
The Add button enables. 
 

—OR— 
 

If the address is not correct, click on the Reject button and repeat Steps 2 and 3. 

6 Click on the Add button. 
The new address displays at the bottom of the window in the address grid. If you 
selected the address as Primary and there was already a Primary address listed, the 
old Primary address is end-dated. 

7 Click on the Save button. 
The following message displays:  
“Changes have been saved.” 

8 Click on the OK button.  
The Stage Composition tab displays.  

 

Step-by-Step: 
End-Dating an Address 

1 On the Stage Composition tab, select the appropriate person from the Person List 
and click on the Address button.  
The Maintain Address window displays. 

2 Select the address to end-date from the grid at the bottom of the window. 
The Set End Date button enables. 

3 Click on the Set End Date button.  
The End Date field in the Address Information section populates with the system 
date.  

4 Click on the Modify button. 
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5 Click on the Save button. 
If you end-dated the primary address, the following 
message displays:  
“At least one address must be designated as 
primary.” 
Click on the OK button to close the message and 
follow Steps 2 through 8 in “Adding an Address” to 
record the new primary address.  
 

—OR— 
 

If the address you end-dated was not the primary address, the address is end-dated 
and the following message displays: 
“Changes have been saved.” 
Click on the OK button. The Stage Composition tab displays. 

 

These changes may impact the 
WMS case information. Please 
refer to the WMS information in 

Module 4. 

The Maintain Phone Window 
The Maintain Phone window enables you to view and record 
multiple phone numbers for an individual. Phone records are 
distinguished by type, such as residence, business and cellular. 
Each phone record also includes a start date and, if applicable, 
an end date, allowing you to view both current and historical 
phone information. In addition, a phone record can be 
designated as “Primary” or as “Invalid.” A Primary phone record 
is the phone number where the person can most often be 
contacted; an Invalid phone record is a phone number that was 
never correct. Only one valid Primary phone record can exist for 
a person at one time. When you add a new Primary phone 
record for a person, the old Primary phone record end-dates 
automatically. 

 

 

Phone numbers should be 
invalidated only if they were 

never correct. 

Phone numbers that were 
correct but have changed are 

end-dated. 
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Step-by-Step: 
Adding a Phone Number 

1 On the Stage Composition tab, select the appropriate person from the Person List 
and click on the Phone button.  
The Maintain Phone window displays. 

2 Record the new phone information in the Phone Information section. 
The Add button enables. 

3 Select the Primary check box to designate this phone number as the primary 
number, if applicable. 

4 Click on the Add button. 
The new phone information displays in the grid at the bottom of the window. If you 
selected the phone number as Primary and there was already a Primary phone 
number listed, the old Primary phone number is end-dated. 

5 Click on the Save button. 
The following message displays:  
“Changes have been saved.” 

6 Click on the OK button.  
The Stage Composition tab displays. 
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The Maintain Primary Address and Phone Window 
During the course of a services case, a family may move to a new address or may change their 
phone number. In order to maintain an accurate case record, you need to update this 
information in CONNECTIONS. Use the Maintain Primary Address and Phone window to 
accomplish this task. 

Unlike the Maintain Address or Maintain Phone windows, the Maintain Primary Address and 
Phone window enables you to apply an address or phone number to multiple individuals without 
having to retype information. 

 

The Maintain Primary Address and Phone window is organized into two main sections: 

• The detail section in the upper half of the window (comprised of the Primary Address 
Information and Primary Phone Information sections) 

• The person grid in the lower half of the window 

The fields included in the Primary Address Information and Primary Phone Information sections 
are the same as those listed for the Maintain Address and Maintain Phone windows, 
respectively. (See pages 26 and 29 for more information on those windows.) The Person grid 
lists the individuals involved in the FSS stage and their respective address and phone 
information. 
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You can maintain address and/or phone information on this window using one of the following 
methods: 

• Record the new address and/or phone information in the fields in the upper half of the 
window, then select the individuals to whom the new primary address and/or phone 
information should apply. (See the step-by-step instructions for “Direct Entry Method” on 
this page.) 

—OR— 
• Link an individual to a pre-existing case address. (See the step-by-step instructions for 

“Linking Method” on page 33.) 

Step-by-Step: 
Maintaining Primary Address and/or Phone Information for  
Multiple Individuals  
(Direct Entry Method)  

1 From the Stage Composition tab, click on the Options menu and select Maintain 
Primary Address/Phone. 
The Maintain Primary Address and Phone window 
displays. 

 

2 Record the new address information in the Primary 
Address Information section. 
The Validate button enables. 

3 Click on the Validate button. 
The address validation window displays. 

4 If the resulting address is correct, click on the 
Accept button to accept it. 
 

—OR— 
 

If the address is not correct, click on the Reject button and repeat Steps 2 and 3. 

5 Record the new phone information in the Primary Phone Information section, 
including the Type. 

You can choose to update 
either the primary address or 
phone number in this window; 

you do not have to update both. 

6 Click on the name of the individual to whom you want to apply the new address 
and/or phone information. 
To select multiple individuals, hold down the Ctrl key while you click on each 
person’s name. 

7 Click on the Save button. 
The following message displays:  
“Changes have been saved.”  

8 Click on the OK button. These changes may impact 
the WMS case information. 

Please refer to the WMS 
information in Module 4. 

9 Click on the Cancel button to exit the Maintain 
Primary Address and Phone window. 
The Stage Composition tab displays. 
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Step-by-Step: 
Maintaining Primary Address and/or Phone Information for  
Multiple Individuals 
(Linking Method) 

1 From the Stage Composition tab, click on the Options menu and select Maintain 
Primary Address/Phone. 
The Maintain Primary Address and Phone window displays. 

2 Click on the gray box to the left of the person’s name to select the individual who is 
associated with the pre-existing case address and/or phone information. 
An arrow displays to the left of the selected person’s name. 

3 Right-click to open the shortcut menu, then select Use Address or Use Phone or 
Use Both Address and Phone, as applicable. 

4 If you selected Use Address or Use Both Address and Phone in Step 3, click on 
the Validate button to validate the address. 

5 If the resulting address is correct, click on the Accept button to accept it. 
 

—OR— 
 

If the address is not correct, click on the Reject button. 

6 Click to select the individual to whom you want to link this pre-existing case address 
and/or phone information. 
To select multiple individuals, hold down the Ctrl key while you click on each 
person’s name. 

7 Click on the Save button. 
The following message displays:  
“Changes have been saved.”  

These changes may impact 
the WMS case information. 

Please refer to the WMS 
information in Module 4. 

8 Click on the OK button. 

9 Click on the Cancel button to close the Maintain 
Primary Address and Phone window. 
The Stage Composition tab displays. 
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Adding or Correcting Person Identifier Numbers 
CONNECTIONS enables you to record various identification 
numbers, such as a Social Security Number (SSN) or WMS 
Client Identification Number (CIN). Person identifiers are very 
helpful in distinguishing persons who may have the same name 
or other similar demographic information. Person identifiers 
help CONNECTIONS users maintain data integrity in the 
system. This information is recorded on the Person Identifiers 
window.  

 
A person’s WMS CIN cannot be 

changed in CONNECTIONS, 
since it is WMS-generated; it 
must be changed in WMS. A 

WMS CIN can only be corrected 
(or invalidated) in 

CONNECTIONS (if it was 
recorded incorrectly). 

Person identifiers can be added to the system, corrected and 
invalidated (if recorded incorrectly). Person identifiers can also 
be end-dated. When an identifier was valid at one time, but is 
no longer valid, you “end-date” it; marking a person identifier as 
“Invalid” is the only way to end-date it. 

 

Step-by-Step: 
Adding a Person Identifier Number 

1 On your Assigned Workload, select the appropriate FSS stage. 
The Tasks… button enables. 

2 Click on the Tasks… button. 
The Family Services Stage window displays. 

 3 Select the appropriate person on the Person List. 

4 Select an ID type by clicking in the blank field under 
the Type column in the Person Identifiers grid and 
selecting from the resulting list using the drop-down 
arrow. 
If you choose “Other” as the type, you must enter 
Comments.  

5 Type the ID number into the Number field. 
Press the Tab key or click in the Comments field to record comments. Type directly 
into the field. 

Person Identifier numbers are 
numbers that originate outside 
of the CONNECTIONS system 
(e.g., SSN, WMS, CIN). They 

are not the same as the 
CONNECTIONS-generated 

Person Identification Number 
(PID). 

6 Click on the Save button. 
The window refreshes. The new identifier displays in the Person Identifiers grid when 
that person is selected from the Person List. 

7 Click on the Close button. 
The Assigned Workload displays. 
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Step-by-Step: 
Correcting a Person Identifier Number 

1 On your Assigned Workload, select the appropriate FSS stage. 
The Tasks… button enables. 

2 Click on the Tasks… button. 
The Family Services Stage window displays. 

3 Select the appropriate person on the Person List. 

4 Click on the gray box to the left of the appropriate record in the Person Identifiers 
grid to select it.  
The row highlights. 

5 Make the appropriate corrections to the person identifier in the Number field.  

6 Click on the Save button. 
The window refreshes. The new identifier displays in the Person Identifiers grid when 
that person is selected from the Person List. 

7 Click on the Close button. 
The Assigned Workload displays. 

 

Step-by-Step: 
Invalidating a Person Identifier Number 

1 On your Assigned Workload, select the appropriate FSS stage. 
The Tasks… button enables. 

2 Click on the Tasks… button. 
The Family Services Stage window displays. 

3 Select the appropriate person on the Person List. 

4 Click on the gray box to the left of the appropriate record in the Person Identifiers 
grid to select it.  
The row highlights. 

5 Click in the INV field and select Yes using the drop-down arrow. 
The Save button enables. 

6 Click on the Save button. 
The changes are saved. The system populates the End Date field with the date you 
invalidated the identifier. 

7 Click on the Close button. 
The Assigned Workload displays. 
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Maintaining Relationships 

In order to understand family dynamics, it is important to determine how the individuals in a 
case are related to one another. This helps every worker with a role in the case keep track of 
people who affect a child’s permanency, safety and risk of harm or reduction of risk to the child. 

The Family Relationship Matrix window (accessed via the Relationship Matrix button on the 
Stage Composition tab) provides a number of case recording benefits: 

• Organizing information about people who are involved in the family’s services case 

• Capturing information about resources for children and individuals who affect that child’s 
safety and risk status 

• Clearly and concisely identifying all of the relationships and reciprocal relationships in 
the family 

Using the Family Relationship Matrix window, you can create, modify or invalidate relationships. 
CONNECTIONS provides system efficiencies to support you in completing the matrix, including 
the following: 

• When a relationship is established, the system automatically creates the implied (or 
“reciprocal”) relationship. An implied relationship is one that can be deduced from a 
previously recorded relationship.  

• Once an individual’s relationships have been established with everyone in the 
household, that individual’s name is disabled (grayed out) on the Family Relationship 
Matrix window.  

The Family Relationship Matrix window contains a header, person lists, a relationships values 
selection field, the Relationships grid and a footer. 

The Relationships grid in the lower half of the window displays all of the relationships and 
implied relationships that have been established. There are two display modes within this grid: 
The Full List (default view) displays all of the relationships recorded for all of the people in the 
FSS (or the FSI, if the matrix is created during the FSI). The Individual List (which is displayed 
by clicking on the Individual List button in the footer) displays the selected individual on the 
Person One list and all of that person’s relationships with members of the Person Two list.  

The Relationships grid contains the following fields: 

• Person One • Age • Relationship 

• Person Two • Age • Transaction (TX) Date 

 • Close Date • Status 

The following buttons display in the footer of the window: Modify, Invalidate, Individual List, 
Save, Cancel and Close.  
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Step-by-Step: 
Completing the Family Relationship Matrix 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the appropriate FSS stage to select it. 
The Tasks… button enables. 

 3 Click on the Tasks… button. 
The Family Services Stage window displays with the 
Stage Composition tab active. 

When you build family 
relationships, select a parent 
from the Person One list first; 

this establishes implied 
relationships. By completing the 

FRM in this order, you will be 
effectively using the system 

efficiencies to create 
implied/reciprocal relationships. 

4 Click on the Relationship Matrix button. 
The Family Relationship Matrix window displays. 

5 Create a relationship by selecting a person in the 
Person One list by clicking on the person’s name. 

6 Click on the drop-down arrow for the Relationship 
field and select the appropriate relationship. 

7 Select the person(s) to whom that relationship 
applies from the Person Two list by clicking on the 
corresponding check box. 
More than one person can be selected. For example, there may be two or more 
children in the Person Two list to whom Person One is the mother. 

8 Click on the Add button.  
The assigned relationship then displays in the Relationships grid with a status of 
“New.” Once a “New” relationship is saved, the status of the relationship changes to 
“Active.” “Active” is the status of all current saved relationships. 

Also, complete all relationships 
for that person before starting 
them for the next individual on 

the Person One list. 

9 Click on the Save button to save the information you recorded to the database. 
The assigned relationship displays in the Relationships grid as “Active.” 
Additional relationships can be added by repeating steps 5 through 9 until you have 
added and saved all of the necessary relationships. When you have completed all 
required relationships, the following message displays: 
“All Relationships are Complete.” 

10 Click on the Close button. 
The Family Services Stage window displays. 
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Step-by-Step: 
Modifying the Family Relationship Matrix 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

 

2 Click on the appropriate FSS stage to select it. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Family Services Stage window displays with the 
Stage Composition tab active. 

You should modify a 
relationship that has changed 

(e.g., Putative Father to Father); 
however, you should invalidate 
a relationship that was never 

correct. 

4 Click on the Relationship Matrix button. 
The Family Relationship Matrix window displays. If 
the matrix is complete, the following message 
displays: 
“All Stage Relationships are Complete.” 

5 Select the relationship you would like to modify from 
the Relationships grid at the bottom of the window. 
The Modify button enables. 

 
6 Click on the Modify button. 

The relationship populates the Person One and 
Person Two fields at the top of the window. 

If you are attempting to modify a 
relationship and receive an error 

message stating that you 
cannot modify that relationship, 
select the reciprocal relationship 

to complete the modification. 
For example, if the Mother is 

selected in the Person One list 
and the Child is selected in the 

Person Two list when you 
receive an error message, 

select the Child in the Person 
One list and the Mother in the 
Person Two list to complete  

the changes. 

7 Using the drop-down arrow in the Person One is 
the … field, select the relationship. 
The Add button enables. 

8 Click on the Add button. 
The modified relationship is added to the 
Relationships grid. 

9 Click on the Save button. 

10 If you wish to modify another relationship, repeat 
steps 5 through 9. 
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Step-by-Step: 
Modifying the Family Relationship Matrix After a Person Has Been 
Added to the Stage Composition 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the appropriate FSS stage to select it. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Family Services Stage window displays with the Stage Composition tab active. 

4 Click on the Relationship Matrix button. 
The Family Relationship Matrix window displays. 

5 Select the person added to the stage from the Person One list. 

6 Click on the drop-down arrow for the Relationship field and select the appropriate 
relationship. 

7 Select the person to whom that relationship applies from the Person Two list by 
clicking on the corresponding check box. 

8 Click on the Add button.  
The assigned relationship then displays in the Relationships grid with a status of 
“New.” Once a “New” relationship is saved, the status of the relationship changes to 
“Active.” “Active” is the status of all current saved relationships. 

9 Click on the Save button to save the information you recorded to the database. 
The assigned relationship displays in the Relationships grid as “Active.” 
Additional relationships can be added by repeating steps 5 through 9 until you have 
added and saved all of the necessary relationships. When you have completed all 
required relationships, the following message displays: 
“All Stage Relationships are Complete.” 

10 Click on the OK button. 

11 Click on the Close button. 
The Family Services Stage window displays. 

 

 

 

 

CONNECTIONS Step-by-Step Guide Page 39 
Data Maintenance for Family Services Stages  Version 1 (10/11/2005) 



 

Step-by-Step: 
Invalidating a Relationship 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the appropriate FSS stage to select it. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Family Services Stage window displays with the Stage Composition tab active. 

4 Click on the Relationship Matrix button. 
The Family Relationship Matrix window displays. If the matrix is complete, the 
following message displays: 
“All Stage Relationships are Complete.” 

5 Select the relationship you would like to invalidate from the Relationships grid at the 
bottom of the window. 
The Invalidate button enables. 

6 Click on the Invalidate button. 
If the matrix was complete when you accessed it, the following message displays: 
”The Relationship Matrix is no longer complete. Enter a new relationship to replace 
invalidated relationship(s). Failure to do so will disable FASP launching and approval 
processes.” 
Proceed to Step 7. 
 

—OR— 
 

If the matrix was not complete, skip to Step 8.  

7 Click on the OK button. 

8 Click on the Save button. 
To invalidate another relationship, repeat steps 5 through 8. 

9 Follow steps 5 through 9 in “Completing the Family Relationship Matrix” on page 37 
to enter a new relationship for each one that you invalidated. 
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Maintaining Tracked Children Information 
A tracked child is defined as a child in a Family Services Stage with a Type of “Child Welfare 
Services” (FSS/CWS) or “Child Case Record” (FSS/CCR) and who has an active Program 
Choice and Permanency Planning Goal (PPG) and who is 
receiving Child Welfare services. The Tracked Children Detail 
window provides for the recording of critical information about 
children related to their respective PPGs and the programs and 
services they are receiving to achieve that outcome. Although 
this information can now be recorded in CONNECTIONS, it is 
important to note that CCRS remains the official system of 
record and as such, that information must continue to be 
maintained in CCRS. The Tracked Children Detail window 
ensures that the information recorded remains with the child as that child moves from one stage 
to another in CONNECTIONS, creating an historical record. A child can only be tracked in one 
CONNECTIONS Family Services Stage at a time and will be tracked from the time an active 
Program Choice and PPG is selected for that child until both the Program Choice and PPG are 
end-dated. The child may be listed in another stage in CONNECTIONS. 

 
An individual cannot be a 

tracked child and a caretaker in 
the same FSS stage. 

Any worker with a role in the FSS/CWS or FSS/CCR, as well as any user with access to that 
worker’s Assigned Workload, may view and modify (depending on the security set elsewhere in 
the system) the information on the Tracked Children Detail window, with the following 
exceptions: 

• CCRS/CONNECTIONS Placement Information (on the Placement Information tab) 
may be viewed for any child with a Program Choice of “Placement,” but may not be 
modified on this window. 

• The Completely Freed for Adoption check box (on the Placement Information tab) is 
only visible to the Case Manager and can only be selected by the Case Manager.  

The Tracked Children Detail window is accessed through the Tracked Child Detail button on 
the FASP window for an FSS/CWS or FSS/CCR stage. The Tracked Children Detail window 
can be accessed from: the CONNECTIONS Toolbar through a Case Search (provides view-only 
access); via the Assigned Workload; or through the Unit Summary window. (See the step-by-
step instructions, starting below, for each route of access.) Upon opening the Tracked Children 
Detail window, the Program Choice/PPG tab is active and the Associate Worker tab enables. 
The Placement Information tab enables if at least one child has a Program Choice of 
“Placement.” 

 

Step-by-Step: 
Opening the Tracked Children Detail Window via  
the Assigned Workload 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Select the appropriate FSS stage and click on the Tasks… button. 
The Family Services Stage window displays.  
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3 Click on the Family Assessment and Service Plan tab. 
The FASP window displays. 

4 Click on the Tracked Children button.  
The Tracked Children Detail window displays with the Program Choice/PPG tab 
active. 

 

Step-by-Step: 
Opening the Tracked Children Detail Window via  
the Unit Summary Window 

1 Click on the UNIT button on the CONNECTIONS Toolbar.  
The Unit Summary Window displays. 

2 Enter your agency code in the Agency ID field. 

3 Enter your agency site in the Site field. 

4 Enter your unit code in the Unit field. 

5 For NYC workers only, use the drop-down arrow in the Zone field to select your 
zone. 

6 Click on the Search button. 
A list of workers within your agency displays. 

7 Select a worker (who is assigned a role in the case) from the list. 

8 Click on the Workload… button at the bottom of the window. 
The selected worker’s Assigned Workload displays. 

9 Follow Steps 2-5 of the previous step-by-step instructions on page 41 to open the 
Tracked Children Detail window. 

1 Click on the CASE button on the CONNECTIONS 
Toolbar.  
The Case Search Criteria window displays. 

 

Step-by-Step: 
Opening the Tracked Children Detail Window via a Case Search 

2 Type the Case ID into the Case ID field.  

The Tracked Children Detail 
window is view-only when 

accessed via a Case Search. 
3 Click on the Search button. 

The Case List displays. 

4 Click on the case to select it from the Case List. 
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5 Click on the Summary button. 
The Case Summary window displays. 

 
6 Click on the Family Services Stage. 

7 Click on the Events button. 
The Event List displays for the selected stage. 

8 Click on the “Family Services Stage Opened” event. 

9 Click the Detail… button. 
The Family Services Stage window displays in view-only mode. 

You can also conduct a Case 
Search by entering search 

criteria in the Stage ID 
or Case Name field. 

10 Click on the Family Assessment and Service Plan tab. 
The Family Assessment and Service Plan window displays. 

11 Click on the Tracked Children button. 
The Tracked Children Detail window displays. 
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The Tracked Children Detail Window 

 

The Tracked Children Detail window contains three tabs: 

Program 
Choice/PPG 

This tab allows the Case Manager, Case Planner and Caseworkers to 
view and modify Program Choice and Permanency Planning Goal 
(PPG) information for children in an FSS/CWS or FSS/CCR stage. 

This tab displays placement data from CCRS for a selected child. 
This information may not be modified in CONNECTIONS. The tab 
also allows workers to record the name of the Discharge Resource for 
a selected child, if this information is known. In addition, a Case 
Manager can create a CCR stage for a child from this tab by selecting 
the Completely Freed for Adoption check box, which displays on 
this tab only for Case Managers. This tab is active only if one or more 
children in the stage have been assigned a Program Choice of 
“Placement”; otherwise, the tab is disabled. The discharge resource 
information recorded on this tab in CONNECTIONS does not update 
CCRS. 

Placement 
Information 

This tab is used to Associate Caseworkers to children in the current 
FSS/CWS or FSS/CCR. The purpose of having a Caseworker 
Associated to a child is to allow for key components of the FASP to 
be completed by a Caseworker designated as responsible for 
assessment and planning for that particular child. An Associated 
Caseworker is responsible for Foster Care Issues documentation and 
Child Assessment Scales documentation on the FASP related to a 
specific child or children.  

Associated 
Caseworker 
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Program Choice/PPG Tab 
Assigned workers use the Program Choice/PPG tab to view and modify Program Choice and 
Permanency Planning Goal (PPG) information for children in an FSS/CWS or FSS/CCR stage. 
As the needs of the children change, workers may need to add new Program Choices or modify 
the effective dates and end dates of existing Program Choices. This tab is also used to make 
changes to the service program being provided to the children to ensure that the information 
about these children is up-to-date and accurate. The information continues to follow them 
throughout the life of the stage. 

The Program Choice(s) selected for the child(ren) determines which PPG choices are available. 
If Program Choices are modified or new choices are added, you may be required to change the 
currently active PPG. The PPG represents the most desirable and most realistic permanent 
living arrangement for the child(ren). Only one PPG may be set for each child. 

 

When the Tracked Children Detail window opens, the Program Choice/PPG tab is active. The 
tab consists of four sections: 

• Select Children grid • Program Choice Information 

• Permanency Planning Goal (PPG) Information • Footer 

The Select Children grid contains the following columns: 

Child The name(s) of the child(ren) in the Family Services Stage 
(FSS/CWS or FSS/CCR) 

Age  The age of the corresponding child associated with the FSS/CWS 
or FSS/CCR (based on the FASP due date) 

Caseworker  The name of the Caseworker who has been Associated to the 
corresponding child on the Associated Caseworker tab 

The Select Children grid also contains the All check box, which allows you to select all children 
on the list. This function can only be used when all children in the grid have the same Program 
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Choice(s) and Permanency Planning Goal(s). If the children have different Program Choices 
and/or Permanency Planning Goals and the All check box is selected, the fields below the 
Select Children grid are not populated you cannot modify them. You must then deselect the All 
check box. 

The Program Choice Information section contains the following columns: 

Program Choice  A list of Program Choice(s) for the selected child(ren) 

The date that the corresponding Program Choice became 
effective 

Eff Date 

The date that the corresponding Program Choice ended (if it is not 
the current Program Choice, which continues to be valid) 

End Date 

These columns can be sorted by any column (in ascending or descending order) by clicking on 
the column name. 

The Program Choice Information section also contains the following fields: 

Program Choice  This field allows you to select a new program, which will be added 
to the child’s record. 

This field contains a calendar from which you can set the effective 
date of an existing or new Program Choice. 

The Effective Date cannot precede the stage’s opening date and 
cannot be later than the current system date. The Effective Date 
also cannot precede the date of the last approved FASP. By default, 
the Effective Date for new programs is set to the current system 
date. The Effective Date cannot be modified if: 

Effective Date  

• the Program Choice is "Placement" for an FSS/CCR stage; 
or 

• the Program Choice is "Protective" and an open CPS 
Investigation is associated with the FSS/CWS stage. 

This field contains a calendar from which you can set the End Date 
for an existing program. 

The End Date is not required, but may be recorded at any time. The 
End Date may not precede the effective date and cannot be set to a 
date in the future. By default, the End Date is set to the current 
system date, but this date does not become active unless you 
select the check box in this field or click on the drop-down arrow 
and select a date from the resulting calendar. 

End Date  

The End Date cannot be modified if: 
• the Program Choice is “Placement” for a FSS/CCR stage; or 
• the Program Choice is “Protective” and an open CPS 

Investigation is associated with the FSS/CWS stage. 

Page 46 CONNECTIONS Step-by-Step Guide  
Version 1 (10/11/2005) Data Maintenance for Family Services Stages 



 

Three buttons display at the bottom of the Program Choice Information section: 

Allows you to add a Program Choice to the Program Choice 
Information 

Add  

Changes the Effective Date and/or End Date for the selected 
Program Choice 

Modify  

Clears any additions or modifications and returns the section 
to its original state 

Clear  

The Permanency Planning Goal (PPG) Information section contains the following columns: 

PPG  Displays the current Permanency Planning Goal for the 
corresponding child 

Displays the date that the corresponding PPG became effective Eff Date  

Displays the date that the corresponding PPG ended as the 
active PPG 

End Date  

 

This section also has five fields: 

PPG  This field allows you to select a new Permanency Planning Goal 
(PPG). If an active PPG already exists, the existing PPG end-
dates automatically with the effective date of the new PPG when 
you click on the Add button. 

This field allows you to specify a sub-category of the selected 
PPG. This field enables only if you selected “Return to Parent,” 
“Referral for Legal Guardianship/Custody” or “Place in Another 
Planned Living Arrangement” as the Permanency Planning Goal. 

Sub Category  

Effective Date  This field contains a calendar selector, from which you can set the 
Effective Date of an existing or new PPG. The Effective Date 
cannot precede the date of the last approved FASP or the Case 
Initiation Date (CID) if no approved FASP exists, and cannot 
precede the End Date of any previous PPG choice. The Effective 
Date cannot be a future date. 
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This field contains a calendar selector, from which you can set the 
End Date for an existing PPG. The End Date is not required, but 
may be recorded at any time. The End Date may not precede the 
Effective Date. By default, the End Date is set to the current 
system date, but this date does not become active unless you 
select the check box in this field or click on the drop-down arrow 
and select the date from the resulting calendar. 

End Date  

Anticipated 
Completion Date  

This field contains a calendar selector, from which you can select 
the date when you anticipate that the selected PPG will be 
achieved. The default date is the system date, but this date does 
not become active unless you select the check box in this field or 
click on the drop-down arrow and select the date from the 
resulting calendar. 

Four buttons display at the bottom of this section: 

Comments  After selecting an existing Permanency Planning Goal, click on this 
button to open the PPG Change window, in which you can view or 
modify the reasons for the last change in PPG. This button is 
disabled if no comments have been recorded. 

Add  After selecting a new PPG and Subcategory, click on the Add 
button to add the new selections. If another PPG already exists for 
the child, the previous PPG is end-dated with the Effective Date of 
the new PPG, and the new PPG displays. This also opens the 
PPG Change window, where you must explain the reasons for 
changing the PPG. The Add button is disabled until a new PPG 
and Subcategory are selected. 

Modify  Click on the Modify button to update the Effective Date and/or End 
Date for the selected PPG. In order for this button to enable, the 
date field(s) must be selected or active. 

Click on this button to clear any additions or modifications and 
return the section to its original state. The PPG or one of the date 
fields must be selected in order to enable the Clear button. 

Clear  

The footer of the Program Choice/PPG tab consists of the View field (with its corresponding 
radio buttons) and two buttons: 

View When you click on the Active radio button, only currently active 
Program Choice and PPG information is displayed on the Program 
Choice/PPG tab for the selected child(ren). This radio button is 
selected by default when the Tracked Children Detail window opens, 
and is only available when one or more children with historical Program 
Choices and/or historical PPG information are selected in the Select 
Children grid. 

When you click on the All radio button, all active and historical Program 
Choices and PPG information are displayed on the Program 
Choice/PPG tab for the selected child(ren). This radio button enables 
only when one or more children with historical Program Choices and/or 
historical PPG information are selected in the Select Children grid. 
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Save The Save button saves work that has been recorded on the tab. 
Information on the Program Choice/PPG tab cannot be saved unless 
the selected child has been assigned at least one valid Program Choice 
and a valid PPG. 

Clicking on this button cancels all changes made to the tab since the 
last save. The following message displays: 

Cancel 

“Do you want to Cancel? 
Unsaved data and or narratives will be lost.” 

• Click on the Yes button to discard all changes made since the 
last save. 

• Click on the No button to close the message; all changes remain 
pending. 

The PPG Change Window 
The PPG Change window opens automatically if you change the currently active Permanency 
Planning Goal (PPG) or change the sub-category of the active PPG and then click on the Add 
button. This window can also be opened by clicking on the Comments button for a selected 
PPG (for which comments have been recorded and saved). You must document the reason for 
the change.  

 

 

Step-by-Step: 
Viewing Program Choice and PPG Records 

1 On the Tracked Children Detail window, select a child from the Select Children grid 
by clicking on the gray box to the left of the child’s name. 

2 In the View field, click on the Active radio button. 
The grid populates with only active Program Choice(s) and PPG(s) for the child. The 
information displays in end-date order. 

3 In the View field, click on the All radio button. 
The grid populates with all records for the selected child in descending end-date 
order. 
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Adding a Program Choice 
As workers are assessing the needs of one or more children, it may become necessary to add 
new Program Choices. A worker may also be adding a Program Choice to a child within a stage 
for the first time. When it is necessary for a Program Choice to be selected, the worker 
completes the work on the Program Choice/PPG tab by adding a Program Choice. Any worker 
with a role in the Family Services Stage can add or modify the Program Choice for any 
child(ren) being tracked in the FSS/CWS or FSS/CCR. In order to launch a FASP, a Program 
Choice and Permanency Planning Goal must be selected for at least one child within the Family 
Services Stage.  

Any time a Program Choice is added or modified for a child, the Case Planner and Case 
Manager receive system-generated Alert To-Do’s notifying them of the change. Program 
Choices cannot be added for any child if the FASP is in Pending approval status. In some 
cases, a Program Choice must be end-dated before another Program Choice can be added; for 
example, when two Program Choices conflict (such as Placement and Non-LDSS Custody-
Relative/Resource Placement) or when three Program Choices have already been added for 
child. 

Five valid services Program Choices are available for selection in an FSS/CWS stage: 
• Preventive Non-Mandated 
• Preventive Mandated 
• Placement 
• Protective 
• Non-LDSS Custody-Relative/Resource Placement 

Only two valid Program Choices exist for a child in an FSS/CCR: 
• Placement (required to generate an FSS/CCR) 
• Preventive Mandated (the only available Program Choice to add if the child is younger 

than 18) 

 

Step-by-Step: 
Adding a Program Choice 

1 On the Tracked Children Detail window, select a child from the Select Children grid 
by clicking on the gray box to the left of the child’s name. 

2 Click on the drop-down arrow for the Program 
Choice field and select from the resulting list. 

3 Click on the drop-down arrow for the Effective Date 
field and select a date from the resulting calendar. 

 

You can select multiple children 
from the Select Children grid by 
holding down the Ctrl key while 
clicking on the gray box to the 
left of each child’s name that 

you want to select. 

4 Click on the drop-down arrow for the End Date field, 
if applicable, and select a date from the resulting 
calendar. 

5 Click on the Add button. 

6 Click on the Save button. 
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You can select all children from the grid by clicking on the Select All Children check box. You 
can use this feature when all children in the FSS/CWS have the same Program Choice. 

By clicking on the Add button to add the new Program Choice to the child’s record, the system 
automatically verifies that there are no more than three active Program Choice records for any 
one child. 

If the Program Choice that has been selected invalidates the active Permanency Planning Goal, 
the following message displays: 

“The addition of this program choice will invalidate the active PPG. Continue?” 

• If you click on the Yes button, you need to add a PPG; the active PPG is end-dated. 

• If you click on the No button, you are directed back to the Program Choice field on the 
Tracked Children Detail window. 

When you click on the Add button and the selected Program Choice is “Protective,” the 
following message displays: 

“This FSS was not created from a CPS INV.  
Is a program choice of Protective appropriate?” 

• Click on the Yes button to retain the Program Choice.  

• Click on the No button to return to the Tracked Children Detail window. 

If “Protective” is being added as the Program Choice for a selected child or children in a 
FSS/CWS and not all children are selected, the following message displays: 

“A Program Choice of Protective will be assigned to all children in the case.” 

• If you click on the OK button, the Program Choice is added to all children in the stage. 

• If you click on the Cancel button, the Tracked Children Detail window displays; the 
Program Choice is not changed. 

Modifying a Program Choice 
Once a Program Choice has been recorded and saved, it cannot be deleted. If a Program 
Choice needs to be modified, the previous Program Choice is end-dated and a new Program 
Choice is recorded. Any worker with a role in a stage can modify a Program Choice. This 
process helps workers maintain both a current and historical record of Program Choices for 
tracked children. 

If you select a Program Choice with an End Date that is earlier than the current system date, it 
is considered an historical record and can no longer be modified. For Program Choices that 
have no End Dates, if you attempt to modify the End Date to a date that is earlier than the 
Effective Date, the following message displays: 

“Program Choice end date must be greater than its effective date.” 

End Dates and Effective Dates cannot be: 

• future dates; 

• earlier than the stage opening date; or 

• later than the system date for the selected child(ren). 
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Step-by-Step: 
Modifying Program Choice Dates 

1 On the Tracked Children Detail window, select a child from the Select Children grid 
by clicking on the gray box to the left of the child’s name. 

2 From the Program Choice grid, select a Program Choice. 

3 In the Effective Date field, click on the check box to accept the system date, or click 
on the drop-down arrow and select from the resulting calendar. 

4 Click on the Modify button. 

5 Click on the Save button. 

Adding a PPG 
The purpose of adding a Permanency Planning Goal (PPG) is to allow workers to record a new 
PPG for each child for whom child welfare services have been authorized. A PPG describes the 
most desirable, realistic, permanent living arrangement for the child.  

Any worker with a role in the stage can add a PPG. In order to launch a FASP, a Program 
Choice and PPG must be selected for at least one child within the Family Services Stage. 
Adding a PPG may also be executed, as necessary, as part of maintaining details for tracked 
children in an existing FASP. 

Available PPG categories and sub-categories are determined by the Program Choice selections 
made for the child(ren). When you add a PPG, the available selections display in the drop-down 
list based on the Program Choice for the selected child. If you modify the Program Choice(s), 
you may be required to select a different PPG that is consistent with the new Program Choice. 

Anytime you change a child’s PPG, you need to explain (in the PPG Change window) the 
reason for making the change. This window opens automatically when you click on the Add 
button after selecting a new PPG. Whenever the PPG is changed, the Case Planner and Case 
Manager receive system-generated Alert To-Do’s, notifying them of the change. Each child can 
only have one active PPG at a time. Whenever a new PPG is added, the previous PPG is end-
dated by the system. 

The following PPG selections require that a PPG sub-category be selected: 

PPG PPG Sub-Category 
Parent Return to Parent 
Non-Parent Caregiver 
Relative Referral for Legal 

Guardianship/Custody Non-Relative 
Discharge to Independent Living Place in Another 

Planned Living 
Arrangement 

Discharge to Independent Living/Unaccompanied 
Refugee Minor 
Discharge to Adult Residential Care 
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Step-by-Step: 
Adding a Permanency Planning Goal 

1 On the Tracked Children Detail window, select a child from the Select Children grid 
by clicking on the gray box to the left of the child’s name. 
The Program Choice Information and Permanency Planning Goal Information 
sections enable. 

2 Click on the drop-down arrow for the PPG field and 
select from the resulting list. 
This field enables only if a Program Choice has 
been recorded for the selected child. 

3 Click on the drop-down arrow for the Effective Date 
field and select a date from the resulting calendar. 

 
A PPG may be backdated (in 

the Effective Date field) to the 
date of the last approved FASP 

or the Case Initiation Date 
(CID), whichever is more recent. 

4 Click on the drop-down arrow for the Anticipated 
Completion Date field and select from the resulting 
calendar. 

5 Click on the Add button. 
The PPG detail is added to the PPG grid. 

6 Click on the Save button. 

If all children within the stage have the same Program Choice and the same PPG, you can click 
on the Select All check box to select all of the children in the stage to add their PPG at the 
same time. 

When adding a Permanency Planning Goal, the PPG Effective Date cannot be earlier than the 
End Date of any previous historical PPG. If the Effective Date you record is earlier than the End 
Date of a previous PPG, the following message displays: 

“The effective date must be greater than or 
equal to the end date of any previous PPG.” 

Modifying the PPG 
As you work with the children and families to whom services are being provided, it may be 
necessary to change the Permanency Planning Goal for the child(ren). It is important to change 
the goal only when it is in the best interests of the child(ren) to have a new plan for a safe and 
permanent living arrangement. Anytime a change is made to a PPG, you must explain the 
reason for the change. 

 

Step-by-Step: 
Documenting the Reason for a PPG Change 

1 On the Tracked Children Detail window, select a child from the Select Children grid 
by clicking on the gray box to the left of the child’s name. 
The Program Choice Information and Permanency Planning Goal Information 
sections enable. 
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2 Click on the drop-down arrow for the PPG field and select from the resulting list. 

3 Click on the Add button. 
The PPG Change window displays. 

4 In the narrative field, explain why you are changing the PPG. 

5 Click on the OK button. 
The Tracked Children Detail window displays. A system-generated Alert To-Do is 
generated and sent to the Case Manager and Case Planner with the following 
description: “Change in Program Choice/PPG in {stage name} should be reviewed 
and updated in CCRS.” 

6 Click on the Save button. 

If you select a sub-category of “Discharge to Independent Living,” “Discharge to Independent 
Living/Unaccompanied Refugee Minor” or “Discharge to Adult Residential Care,” you need to 
record on the PPG Change window the reason for selecting those discharge options. 
Specifically, you need to document the reason(s) why it is not in the best interest of the child to 
select “Return to Parent,” “Place for Adoption,” “Refer to Guardianship” or “Place with a 
Relative.” 

Modifying PPG Dates 
The purpose of modifying PPG dates is to update the Effective Date, Anticipated Completion 
Date and/or End Date of a Permanency Planning Goal previously recorded for a tracked child in 
a Family Services Stage. It is important for workers to be able to modify these dates to keep the 
tracked child’s recorded information accurate and up-to-date. End Dates and Effective Dates 
cannot be: 

• future dates; 

• earlier than the stage opening date; or  

• later than the system date for the selected child(ren). 

 

Step-by-Step: 
Modifying a PPG Date 

1 On the Tracked Children Detail window, select a child from the Select Children grid 
by clicking on the gray box to the left of the child’s name. 
The Program Choice and Permanency Planning Goal Information sections enable. 

2 On the PPG grid, select the existing PPG (for which you are modifying date 
information) by clicking on the gray box to the left of the PPG. 

3 In the Anticipated Completion Date field, select a new date. 
Either click on the check box to accept the current system date, or click on the drop-
down arrow and select from the resulting calendar. 

4 Click the Modify button. 
The information in the PPG grid updates. 

5 Click on the Save button. 
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When a child has information recorded in a pending FASP and an attempt is made to change 
that child’s information, the following message displays: 

“There is a FASP in pending approval status. Program Choice and Permanency 
Planning Goal may not be changed. Contact the Case Planner.” 

When the Case Manager makes any changes by adding or modifying Program Choice or PPG, 
the following message displays: 

“CCRS should be updated.” 

Saving Your Work 
Clicking on the Save button on the Program Choice/PPG tab saves all changes on the tab to 
the database and verifies that the active PPG corresponds to the active Program Choices. 

If you click the Cancel button prior to clicking Save, the following message displays: 

“Do you want to cancel? 
Unsaved data and/or narrative(s) will be lost.” 

• Click on the Yes button to discard the changes. The tab refreshes and the Tracked 
Children Detail window remains open. 

• Click on the No button to remain on the window; unsaved data remains pending. 

If you click on the Close button prior to clicking on the Save button, the following message 
displays: 

“Do you want to exit? 
Unsaved data and /or narratives will be lost.” 

• Click on the Yes button to close the window. The changes are not saved. 

• Click on the No button to return to the window with the unsaved changes displayed. 
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Associating/Unassociating Workers 
The Associate Worker functionality gives any worker with a role in the FSS/CWS or FSS/CCR 
stage the ability to Associate him/herself to one or more children who do not already have an 
Associated Caseworker. This feature limits who may complete certain portions of the FASP. 
Any worker with a role in an FSS/CWS or FSS/CCR stage can Associate (or Un-Associate) 
him/herself to one or more children. 

If the worker who is Associating or un-associating Caseworkers is the Case Planner, the 
Caseworker list contains all Caseworkers in the stage. If the worker logged on is a Caseworker, 
the Caseworker list is populated with that worker’s name only. 

The Associate Worker Tab 
The Associate Worker tab on the Tracked Children Detail window is used to Associate 
Caseworkers to one or more specific children in the current FSS/CWS or FSS/CCR. Associating 
a Caseworker to a child indicates that the selected worker is responsible for completing Foster 
Care Issues documentation and Child Scale information in the FASP. It does not prevent other 
workers from working with that child or completing other parts of the FASP for that child in the 
overall Service Plan. Also, the Case Planner always may complete Foster Care Issues 
documentation and Child Scale information for any child, regardless of whether or not a 
Caseworker has been Associated to the child. Caseworkers may Associate themselves to any 
child currently not Associated to another Caseworker, and may Un-Associate themselves from 
any child at any time. Caseworkers cannot Associate (or Un-Associate) other workers to any 
child. Case Planners may Associate (or Un-Associate) any Caseworker to any child. 

 

The top section of the Associate Worker tab consists of the Select Children grid, which 
contains three columns: 

The name(s) of the child(ren) in the FSS/CWS or FSS/CCR Child 
The age of the corresponding child associated with the 
FSS/CWS or FSS/CCR 

Age  

The name of the Caseworker who has been Associated to the 
corresponding child on the Associate Worker tab 

Caseworker  
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The Select Children grid also contains the All check box, which allows you to select all children 
from the list. 

The middle section of the tab consists of the Select Caseworker list. For the Case Planner, this 
list displays all workers involved in the FSS/CWS or FSS/CCR stage. For a Caseworker, this list 
displays only that worker’s name. 

In addition to the Cancel button, the bottom section of the tab consists of the following buttons: 

Associate  This button Associates the selected Caseworker to the selected 
child(ren). 

Un-Associate This button Un-Associates the current Caseworker from the 
selected child(ren). Caseworkers may Un-Associate themselves 
from children to whom they are currently Associated; Case 
Planners may Un-Associate any Caseworker from any child. 

1 Click on the Associate Worker tab. 

2 Select a child from the Select Children grid by 
clicking on the gray box to the left of the child’s 
name. 

3 Click on the name of the Caseworker to whom you 
are Associating the child. 

4 Click on the Associate button. 
The Select Children grid updates to include the 
Associated Caseworker. 

 

Step-by-Step: 
Associating a Caseworker 

 

Multiple children or all children 
can be selected from the grid as 
long as they all are not currently 

Associated to another 
Caseworker. 

 

Step-by-Step: 
Un-Associating a Caseworker 

1 Click on the Associated Caseworker tab. 

2 Select a child from the Select Children grid by clicking on the gray box to the left of 
the child’s name. 

3 Click on the Un-Associate button. 
The Select Children grid updates; the previously Associated Caseworker is no longer 
listed. 
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Maintaining Caretaker Information 
In order to launch a FASP, you must first record the Primary Caretaker information; if a 
Secondary Caretaker exists, you must also record the Secondary Caretaker information. 
Caretaker information affects several other components of the 
FSS, including the parent/caretaker scales, the Risk 
Assessment and the FASP. It is important to record this 
information as early as possible in the family services process, 
since changing this information later will clear any existing in-
process Risk Assessment responses, Risk Scales and Re-
Align Households. 

Depending on the specifics involved in a particular FSS, it may 
not always be easy to determine who should be identified as the Primary or Secondary 
Caretaker. The following definitions are intended to provide clarity: 

Primary 
Caretaker 

The Primary Caretaker is an adult (usually the mother) who resides with 
and is legally responsible for the child(ren). When more than one person 
who is legally responsible for the child(ren) resides in the household, the 
biological mother is presumed to be the Primary Caretaker. If the mother 
does not physically reside with the child(ren), the Primary Caretaker is the 
adult who resides in the child(ren)’s home and assumes primary 
responsibility for the care of the child(ren). There can only be one Primary 
Caretaker. 

 
An individual cannot be a 

tracked child and a caretaker in 
the same FSS stage. 

The Secondary Caretaker is: Secondary 
Caretaker • an adult who lives in the child(ren)’s home and assumes some 

responsibility for the care of the child(ren); or 
• an adult who does not reside in the child(ren)’s home, but cares for 

the child(ren) on a regular basis. 

Use the following order to identify the Secondary Caretaker: 
• If the mother has a spouse or intimate partner who is the subject of 

a CPS Investigation (whether alleged or confirmed), select this 
person as the Secondary Caretaker. 

• If two or more potential candidates exist and one of them is the 
subject of a CPS Investigation (whether alleged or confirmed), 
select this adult as the Secondary Caretaker. 

• In all other situations, select the adult who assumes the most 
responsibility for the care of the child(ren), either within or outside 
of the home. 

There will not necessarily be a Secondary Caretaker in a particular family 
unit. If one exists, however, this needs to be documented fully in the FSS. 

 

Page 58 CONNECTIONS Step-by-Step Guide  
Version 1 (10/11/2005) Data Maintenance for Family Services Stages 



 

The Primary/Secondary Caretaker Window 
This window is used to maintain current information regarding the Primary Caretaker (and, if 
applicable, the Secondary Caretaker) for the FSS. 

The Primary and Secondary Caretaker information can be maintained by any worker who has a 
role in the stage unless the FASP is in process; in that instance, only the Case Planner can 
maintain this information. Caretaker information cannot be changed while the FASP is pending 
approval. 

You can maintain the following information on this window: 

Primary Caretaker Secondary Caretaker 
• Select a Primary Caretaker 
• Change the existing Primary 

Caretaker 

• Select a Secondary Caretaker 
• Change the existing Secondary 

Caretaker 
• Remove the Secondary Caretaker 

 

The drop-down list for the Primary Caretaker field contains the names of all people from whom 
the Primary Caretaker can be selected for the FSS. In order to be included in the drop-down list 
for either the Primary Caretaker or Secondary Caretaker field, a person: 

• must not have a Date of Death (DOD); 

• must not have an active PPG or Program Choice; and 

 

• must have a valid address, which cannot be 
“Unknown/Unknown.” (If the person is homeless, use 
the agency’s address.) 

You cannot select the same 
person as both the 

Primary Caretaker and 
Secondary Caretaker. 

If the person who should be designated as the Primary 
Caretaker is not included on the drop-down list, that person 
needs to be added to the FSS before s/he can be selected as 
the Primary Caretaker. (See “Adding or Relating a Person to 
the FSS” on page 17.) 

There can be only one Primary Caretaker and only one Secondary Caretaker (if applicable) for 
a stage; the Primary and Secondary Caretakers cannot be the same person. The Primary 
Caretaker must be selected on this window before the Secondary Caretaker can be selected.  
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When you change the Primary or Secondary Caretaker (or remove the existing Secondary 
Caretaker) while the FASP is in process, the following message displays: 

“FASP is in process. Changing Primary or Secondary Caretaker will clear all Risk responses 
and Family Scales and Re-Align Households. Do you wish to continue?” 

• Click on the Yes button to remove the caretaker indicator from the original caretaker and 
apply it to the newly selected caretaker. All responses to any in-process Risk 
Assessment/RAP within the FSS will be cleared. 

• Click on the No button to cancel the modification process without making any changes. 

In extremely rare circumstances (e.g., if the parents are 
deceased or the children are abandoned), there is no Primary 
caretaker for the stage. On those infrequent occasions when 
this is applicable, click on the No Primary Caretaker Exists 
check box. This check box enables only for the Case Manager 
and Case Planner. If the check box is selected, no Secondary 
Caretaker can be selected. If a Primary Caretaker exists, the 
check box enables; when you select the check box, the Primary 
Caretaker and Secondary Caretaker (if one exists) are removed. 

 

The Primary/Secondary 
Caretakers window is not 
available for CCR stages. 

If the Stage Type is OTI, COI, ICPC or ADVPO, you can record a Primary Caretaker, but 
CONNECTIONS does not require you to do so. 

 

Step-by-Step: 
Recording/Modifying Primary and Secondary Caretakers 

1 On the Stage Composition tab, click on the Caretaker button.  
The Primary/Secondary Caretakers window displays. 

2 On the Primary/Secondary Caretakers window, click on the drop-down arrow for the 
Primary Caretaker field and select from the resulting list. 
 

—OR— 
 

Click on the No Primary Caretaker Exists check box. 

3 If applicable, click on the drop-down arrow for the Secondary Caretaker field and 
select from the resulting list. 
You will not be able to select a Secondary Caretaker if the No Primary Caretaker 
Exists check box is selected. 

4 Click on the Save button. 
The Stage Composition tab displays. 
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Merge and Split Functions 
Duplicate and accidentally combined records are corrected in CONNECTIONS with the Merge 
and Split functions. A Merge joins two separate Person IDs or Case IDs into the same record 
(See “Case Merge/Split Functions” on page 81 for information on Case Merges and Case 
Splits). A Split separates people or cases that were merged in error. The ability to perform 
Merge/Split functions is dependent on the worker’s role and level of security access. 

CONNECTIONS information needs to be maintained in a secure, accurate and reliable manner, 
as well as being readily available for use by workers needing information. The process of 
merging and splitting records is complicated and cannot always be fully undone. Notify your 
supervisor if you notice records that should be merged or split so that necessary corrections can 
be made. 

Person Merge/Split Functions 
In your work with CONNECTIONS, you may come upon multiple records for the same person, 
or records for two separate persons that have been accidentally combined into one. 

Duplicate records can be created during Intake if an Intake worker has limited or unknown 
demographics on a person and therefore, cannot relate that person to an already existing 
person in CONNECTIONS. Duplicates can also result if a worker misses a potential match 
during a Person Search; the worker would then add this person to the case rather than relating 
him/her to the existing person in the system. The opposite situation—accidentally combined 
records—can result if a worker merges records for two individuals who seem to be the same 
person but in fact, are not. Regardless of the reason, duplicate records and accidentally 
combined records pose problems for accurate case management and need to be 
corrected once they are identified. 

The individual authorized to perform the Person Merge/Split function is subject to local district 
policy and procedure. This task may not fall under the scope of the individual worker’s 
responsibilities.  

In order to perform a Person Merge or Split in a closed stage, the worker must be assigned the 
MERGE/SPLIT Business Function and: 

• be the historical Primary worker, Secondary worker or Case Manager; or 

• be the historical Unit Approver (or have a role above that of the Unit Approver in the 
unit of the Primary worker or Secondary worker) and be assigned the CASE/PERS 
SRCH Business Function; or 

• be assigned the ACCESS ALL DIST and CASE/PERS SRCH Business Functions 
(allowing access through a Case Search). 

To perform a Person Merge or Split in an open stage, the worker must be assigned the 
MERGE/SPLIT Business Function and: 

• have a role in the stage; or 
• have maintain access to the Assigned Workload of a worker with a role in the stage; 

or 
• be the Unit Approver (or have a role above that of the Unit Approver in the worker’s 

unit) and be assigned the UNIT SUM ACCESS Business Function. 
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The Person Merge Function 

 

Before completing a Person Merge, a decision must be made 
regarding which person will be carried forward to further stages 
(the Merged Forward Person) and which person will be “retired” 
after the merge (the Merged Closed Person). The Merged 
Forward Person should be the person with the most history. 
This is generally the one with the Person ID number that has 
been in the system longer. It is important to understand how 
the merge affects each of these roles in CONNECTIONS. 

The Merged Forward Person: 
• is carried forward to subsequent CONNECTIONS 

stages; 

When merging two 
Person IDs: 

• Their age difference should 
be within five years. 

• If the Merged Closed 
Person is involved in open 
stages, the following 
message displays:  • appears on the Person List in the current open 

stage, any closed stages and any future stages; and  “The closed person is in open 
stages. Merge with extreme 

caution. Continue?” • is identified by a check mark in the M/S column of 
the Person List on the Stage Composition tab. 

The Merged Closed Person: 
• is “retired” after the merge and information of the new Merged Forward Person is 

used in all open and closed stages; 
• cannot be related to a new stage; and 
• cannot be involved in future system events. 

A Person Merge results in the following system changes: 
• The Merge List on the Person Merge/Split window is updated to reflect the action 

taken. 
• The Merged Forward Person inherits the demographics that have been selected 

and appear in all stages. 
• The Merged Closed Person is no longer linked to any of the stages that were open 

at the time of the merge. These are now linked to the Merged Forward Person. 
• System-generated Alert To-Do’s are sent to the Staff To-Do List of the Primary and 

Secondary workers for any open stages that involve the Merged Forward Person or 
Merged Closed Person. 

A Person Split results in the following system changes: 
• The previously Merged Closed Person becomes active again in the database, but is 

not re-associated with any stages. 
• The previously Merged Closed Person’s pre-merge demographics remain available 

in CONNECTIONS. 
• The events/activities associated with the reactivated person (and approved prior to 

the merge) require data maintenance to again be associated with that person. 
• Events that occurred while the merge was in effect are not associated with the 

reactivated person. 
• System-generated To-Do’s are sent to workers assigned to open stages associated 

with the previously merged person. 
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The Person Forward Selection Window 
The Person Forward Selection window enables you to select specific person information that is 
applied to the Person Forward. The type of information you select—and which person you 
select it from—affects the information that is retained for the Person Forward. 

If you select information from the Person Closed, the primary information for the Person 
Forward is end-dated and the information from the Person Closed is copied to the primary 
record. 

 

Valid person identifier, Language and Religion information is 
retained from the Person Forward, unless the fields are blank. If 
the Person Forward does not have this information recorded, the 
information from the Person Closed is copied to the Person 
Forward. 

Person Merge Warnings and 
Error Messages: 

If you have been given approval to merge person records, 
perform the following steps to complete this task: 

When completing a person 
merge, you may see warnings 

and/or error messages. 
Warnings do not prevent you 
from completing a merge, but 

error messages do. 
 

Step-by-Step: 
Completing a Person Merge from the 
Assigned Workload 

Reasons for Warnings: 
1 On the Assigned Workload, select the stage 

containing the person information that requires 
merging. 

• Both persons must be the 
same sex (if it is recorded). 

• Both people must have a 
DOB that is within 5 years 
(if recorded). 

2 Click on the Options menu and select Person List. 
The Person List displays. 

• One of the persons is 
involved in a fatality report. 

• The Merged Closed Person 
is in an open stage. 

3 Select the person to be merged. 

4 Click on the Options menu and select Person 
Merge/Split. 
The Person Merge/Split window displays with the 
selected person’s name and ID pre-filled in the 
Merged Persons Closed section. 

Reasons for Error Messages: 
• Social Security numbers do 

not match. 
5 Enter the Person ID of the Merged Forward person in 

the ID field of the Merged Persons Forward section. 
• Medicaid number does not 

match. 
• Entered ID is not found, 

verify ID. 
• Services CIN must match. 

6 Click on the Validate button. 
The system checks for an open case and a valid 
Person ID. When the check is complete, the Merge 
button enables. 
NOTE: Several warning or error messages may 
display after selecting the Validate button. For 
warning or error messages that display, click on the 
Close button. 
The Person Merge/Split window displays. For error 
messages the Merge button is disabled. For warning 
messages the Merge button is enabled. 

• NYC Non-Service (NS) 
CIN’s must match 
(NYC only). 

• The Person ID entered has 
the status of person closed 
from a prior merge. 

• The tracked child cannot be 
merged with a person over 
21 years of age. 
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7 Click on the Merge button. 
If the person to be closed is in an open stage, the 
following message displays: 
“The closed person is in open stages. Merge with 
extreme caution. Continue?” 

 
If you determine that the person 
selected to be merged closed 

should, in fact, be merged 
forward, use the Switch 

function: 

8 Click on the Yes button.  
The following message displays:  
“Merge ID# into ID#?” 
The first ID number listed is for the Merged Closed 
Person. The second ID number is for the Merged 
Forward Person.  

1 Click on the Options menu 
on the Person Merge/Split 
window. 

NOTE: If you realize that you have made a mistake 
in selecting your persons, click on the No button. 
The Person Merge/Split window remains open until 
you close it. 

2 Click on the Switch 
command. 

9 Click on the Yes button. 
The Person Forward Selection window displays with the following information for 
both the Person Forward and the Person Closed: 

• Full Primary Name (First, Middle, Last, Suffix) 
• Marital Status 
• Sex 
• Ethnicity 
• Race 
• DOB (including Approximate indicator, 

if applicable) 
• DOD (including Approximate indicator and reason, if applicable) 
• Primary Address 
• Primary Phone 

10 Select information from the Person Forward Selection window by clicking on the 
radio button next to each applicable field. 
The type of information you select—and which person you select it from—affects the 
information that is retained for the Person Forward. See “The Person Forward 
Selection Window” on page 63 for details. 

11 When you have made all of your selections from the Person Forward Selection 
window, click on the OK button.  
The name of the person logged on and the date of the merge displays in the Staff 
NM Merge and Date Merge fields. 

12 Click on the Save button. 
The change is saved in the system and the Person List displays with a check mark in 
the M/S column of the person who was merged. 

13 Click on the Close button. 
The Assigned Workload displays. 
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Step-by-Step: 
Completing a Person Merge from the CONNECTIONS Toolbar 

1 Click on the PERS button on the CONNECTIONS Toolbar. 
The Person Search window displays. 

2 Complete a Person Search by entering the person’s name in the First and Last 
name fields and clicking on the Search button.  
Results will display in the Person Search List below. 

3 From the Person Search List, select the person who is to be listed in the Merged 
Persons Closed section of the Person Merge/Split window. 
The Case List button enables. 

4 Click on the Case List button. 
The Case List displays. 

5 Select the applicable case. 
The Summary button enables. 

6 Click on the Summary button. 
The Case Summary window displays. 

7 Select the applicable stage. 

8 Click on the Options menu and select Person List. 
The Person List displays for the selected stage. 

9 Select the applicable person. 

10 Click on the Options menu and select Person Merge/Split. 
The Person Merge/Split window displays with the selected person’s name and ID 
pre-filled in the Merged Persons Closed section. 

11 Review the name and ID information in the Merged Persons Closed section for 
accuracy. 

12 Enter the Person ID of the Merged Forward person in the ID field of the Merged 
Persons Forward section. 

13 Click on the Validate button. 
The system checks for an open case and a valid Person ID. When the check is 
complete, the Merge button enables. 
NOTE: Several warning or error messages may display after selecting the Validate 
button. For warning or error messages that display, click on the Close button. 
The Person Merge/Split window displays. For error messages the Merge button is 
disabled. For warning messages the Merge button is enabled. 

14 Follow Steps 7 through 13 in “Completing a Person Merge from the Assigned 
Workload” on page 63. 
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1 On the Assigned Workload, select the stage that 
contains the person information that was merged in 
error. 

2 Click on the Options menu and select Person List. 
The Person List displays. 

3 Select the person who was merged in error.  

4 Click on the Options menu and select Person 
Merge/Split. 
The Person Merge/Split window displays. The 
system pre-fills the person’s name into the Merged 
Persons Closed section. 

5 In the list section at the top of the window, select the 
merge you want to split. 
The system fills the merge information into the detail 
section of the window. 

6 Click on the Split button. 
The following message displays: 
“Split ID# from ID#?” 
The first ID number listed is for the Closed Person. 
The second ID number is for the Forward Person. 

7 Click on the Yes button. 

8 Click on the Save button. 
The change is saved in CONNECTIONS. The 
Person List displays.  

9 Click on the Close button. 
The Assigned Workload displays. 

 

 

  

Step-by-Step: 
Completing a Person Split 

Things to Consider  
Before Splitting: 

The Merge Forward Person 
cannot be deleted from the 
stages that were open at the 
time the Person Merge took 
place. The Merged Closed 

Person’s pre-merge information 
is not “reattached” by 

completing a Split. Follow-up 
demographics and case/stage 
maintenance are necessary to 

complete the process. 

You need to record that 
person’s demographic 

information again and re-
associate the person with the 
appropriate case(s)/stage(s). 

The Person Data report 
contains the current and 
historical information of a 

person. 
To run the report: 

1 Select the person on the 
Person List. 

2 Click on the Reports menu 
and select the Person Data 
command. 
The following message 
displays:  

“The report has been launched. 
Check Report List window.” 

3 Click on the OK button. 
4 Click on the RPRTS button 

on the CONNECTIONS 
Toolbar. 

 5 Select the Person Data 
Report and click on the 
Open button. 

This provides a hard copy of all 
information stored in 

CONNECTIONS about a 
specified person including 

merge/split history and 
demographic changes. 

These changes may impact the WMS case information. 
Please refer to the WMS information in Module 4. 
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End-Dating a Person’s Involvement in the FSS 
During the course of an FSS, an individual may need to be 
end-dated from the stage; for example, the biological mother 
ended her relationship with her live-in boyfriend (who has no 
biological children in the household) and he has moved out of 
the home. Individuals who are no longer a part of the stage 
composition cannot be deleted from the stage; they must be 
end-dated. This process preserves an historical record of the 
individual’s involvement in the stage.  

 

You can not end date the 
person designated in WMS as 

the Applicant/Payee in 
CONNECTIONS. A new 

Applicant/Payee must first be 
designated in WMS. 

The End Date Reason window is used to end-date a person’s 
involvement in a Family Services Stage; any worker with a 
role in the stage can maintain this window. 

 

Step-by-Step: 
Opening the End Date Reason Window 

1 From the Stage Composition tab, click to select the individual to be end-dated. 

2 Click on the Options menu and select the End Date Stage Involvement command. 
The End Date Reason window displays. 

 

When end-dating a person, you must record a reason. The drop-down list for this window 
contains the following available End Date Reasons: 

• Services no longer needed • End of court ordered services 

• Services no longer accepted • Adulthood attained 

• Programmatically ineligible • Related/Added in Error 

• Death • CCR Created 
(may display historically; cannot be 
selected) • Moved out of district 

• Agency cannot locate client  
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When you have selected a reason, the Save button enables. Clicking on the Save button saves 
the information you recorded. If you click on the Cancel button, the following message displays: 

“Do you want to exit? 
Unsaved data and/or narratives will be lost.” 

• Click on the Yes button to close the window without saving the information. 

• Click on the No button to return to the window. 

Individuals cannot be end-dated while a FASP is pending approval. If you attempt to do so, the 
following error message displays: 

“Persons may not be end dated while a FASP is pending approval. 
Contact Case Planner.” 

• Click on the OK button to close the message. 

If the individual you are attempting to end-date is a Secondary Caretaker and the FASP is in 
process, the following warning message displays: 

“FASP is in process. End dating Secondary Caretaker will 
clear all Risk responses and Re-align households. Do you wish to continue?” 

• Click on the Yes button to end-date the Secondary Caretaker. You must navigate to the 
Risk Assessment/RAP and re-record all of the non-system-generated risk responses 
before the Case Planner can submit the FASP for approval. 

• Click on the No button to cancel the end-dating process and return to the End Date 
Reason window. 

If the individual you are attempting to end-date is a Primary Caretaker, you must first select a 
new Primary Caretaker (or select the No Primary Caretaker Exists check box [enabled only for 
the Case Manager]) on the Primary/Secondary Caretakers window. If you try to end-date the 
Primary Caretaker, the following message displays: 

“A new Primary Caretaker must be selected (or you must indicate 
that no Primary Caretaker exists) prior to end-dating this person.” 

• Click on the OK button to close the message. 

Once a person is end-dated in an FSS, his/her name will no longer appear in the Family 
Participants list for Progress Notes. Therefore, you should record Progress Notes for which the 
person would have been selected as a Family Participant or Focus before end-dating that 
person. 

When a child in an FSS/CWS stage is freed for adoption, a Child Case Record (CCR) is created 
and the child is end-dated in the FSS/CWS stage. Progress Notes, as well as the FASP, are 
affected by the end-dating of the only child in an FSS/CWS stage:  

• All Progress Notes applicable to the FSS/CWS stage should be recorded prior to 
creating the CCR. 

• Any in-process FASP for the FSS/CWS stage must be completed and submitted for 
approval in the FSS/CWS stage prior to the creation of the CCR. If a Comprehensive or 
Reassessment FASP is in progress for the FSS/CWS stage when the CCR is created, 
the FASP cannot be submitted in the FSS/CWS stage. The FASP must then be 
completed in the FSS/CCR stage as a Reassessment FASP.  
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When you record an End Date Reason and save the information to the database, the 
information for the person you end-dated moves to the Historical Stage Comp window; the end-
date for the person reflects the system date on which you recorded the End Date Reason. All 
relationships for that individual are also end-dated. 

 

Step-by-Step: 
Recording the End Date Reason 

1 On the End Date Reason window, click on the drop-
down arrow for the field and select the appropriate 
End Date Reason from the resulting list. 
The Save button enables.  

These changes may impact 
the WMS case information. 

Please refer to the WMS 
information in Module 4. 

2 Click on the Save button. 
The Stage Composition tab displays. The end-
dated person no longer displays on the tab. 

The Historical Stage Composition Window 
This window displays a list of all individuals who have been end-dated from the FSS. The 
information on this window is view-only. Like the FSS Stage Composition tab, the name fields 
“lock” when you scroll to the right, enabling the person’s name to remain visible when you scroll 
across. 

From this window, you can access address and phone information for end-dated individuals, as 
well as the Family Relationship Matrix to see the relationships for an end-dated person. 
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Step-by-Step: 
Viewing the Historical Stage Comp Window 

1 From the Stage Composition tab, click on the Options menu and select the View 
Historical Stage Comp command. 
The Historical Stage Comp window displays. 

2 To view historical address, phone or Family Relationship Matrix information for an 
end-dated person, click to select the person’s name from the list, then do one of the 
following, as appropriate: 

• Click on the Address button. 
• Click on the Phone button. 
• Click on the Relationship Matrix button. 

3 Click on the Close button to close the Historical Stage Comp window. 
The Stage Composition tab displays. 
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Maintaining Information About Freed Children 
Once a child has been legally freed for adoption, it is necessary to maintain this child’s 
information as a separate case, since the child’s family relationship has been legally severed. 
While creating a separate case for the freed child, it is also crucial to preserve and maintain the 
child’s family history. For example, it is typically desirable for a child to retain sibling 
relationships. CONNECTIONS provides functionality to record specific information for the legally 
freed child. 

The Family of Origin Window 
[within a Child Case Record (CCR) only] 
This window displays the current FSS Stage Composition from the FSS/CWS (Child Welfare 
Services) stage in which the freed child was end-dated. You can access this view-only window 
only from the Stage Composition tab for an FSS/CCR (Child Case Record) stage. 

As with the Stage Composition tab, the name columns “lock” when you scroll to the right, 
enabling to you keep individuals’ names in view when looking at other information about them. 
From this window, you can view address and phone information, as well as the Family 
Relationship Matrix, for the FSS/CWS stage from which the child was freed. 

 

 

Step-by-Step: 
Viewing Family of Origin Information 

1 From the Stage Composition tab, click on the Options menu and select the View 
Family of Origin command. 
The Family of Origin window displays. 

2 To view address, phone or Family Relationship Matrix information from the 
FSS/CWS stage from which the child was freed for adoption, click to select the 
person’s name from the list, then do one of the following, as appropriate: 

a. Click on the Address button. 
b. Click on the Phone button. 
c. Click on the Relationship Matrix button. 

3 Click on the Close button to close the Family of Origin window. 
The Stage Composition tab displays. 
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The Finalize Adoption Window 
Once an adoption is finalized, use the Finalize Adoption window to change the adopted child’s 
name, indicate whether that child will be receiving an Adoption Subsidy and, if so, record the 
new WMS Case Number and Client Identification Number (CIN) for that child. 

In order to maintain information on the Finalize Adoption window, you must be the Case 
Manager (or a person with access to the Case Manager’s Assigned Workload). The Finalize 
Adoption functionality is not available within an FSS that has a Type of “Child Welfare Services” 
(CWS). 

When you open this window, the Legally Freed Child Information is pre-filled from the person 
grid on the Stage Composition tab for the FSS/CCR stage. You can record a new name and/or 
address, if applicable. If an Adoption Subsidy exists for this child, you need to record the new 
WMS Case Number and the new WMS Client Identification Number (CIN) manually for that 
child; there is no interface functionality between CONNECTIONS and WMS for this information. 
If you click on the Yes radio button for the question, “Will an Adoption Subsidy Exist for this 
Child?,” the WMS Case ID and WMS CIN fields will display. Enter the appropriate information in 
these fields. (For information regarding the CONNECTIONS-WMS interface, see the Build 18 
Interfaces Job Aid, which is available on the OCFS CONNECTIONS intranet site.) 
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Changing the child’s name through the Finalize Adoption 
functionality seals all links to the child’s former name. This 
process creates a new person record for the child, recognizing 
the child’s new status. This process differs significantly from the 
functionality on the AKA Names List/Detail window elsewhere 
in CONNECTIONS. When the child’s name is changed on the 
Finalize Adoption window, future searches on the child’s 
original name will not return the child under his/her new name.  

 

Once you complete the Finalize Adoption window and click on 
the Save button, the information you recorded is stored in the 
CONNECTIONS database in order to provide a link between 
the child both prior and subsequent to the finalization of the 
adoption. When you save the information on this window, 
CONNECTIONS generates and displays a new Person ID for 
the child. You cannot perform a “partial” save on this window. 
Once you save this window, the information “freezes.” Only individuals who are assigned the 
ACC SEALED ADOP Business Function will be able to view the information on this window 
once it has been saved to the database, if the CCR stage is closed. 

CONNECTIONS system 
functionality planned for 

Build 19 will provide linkage 
among the CCRs of siblings 

who have been freed for 
adoption. In order to view this 
information, a worker must be 

assigned the 
ACC SEALED ADOP Business 

Function. 

It is imperative that you complete all necessary documentation before completing and saving 
the Finalize Adoption window, since the information cannot be saved “in process”. Furthermore, 
you should close the CCR stage as soon as possible in order to preserve the confidentiality 
rights of the legally freed child. 

 

Step-by-Step: 
Recording a Finalized Adoption in CONNECTIONS 
(Only accessible by the Case Manager within a CCR stage) 

1 On the Stage Composition tab, click on the Options menu and select the Finalize 
Adoption command. 
The Finalize Adoption window displays. 

2 In the Adoption Finalized Child Information section, enter the child’s new legal name 
in the Last Name, First Name and Middle Name fields. 
 

—OR— 
 

Click on the Use Existing button to use the name information displayed in the 
Legally Freed Child Information section. 

3 In the Will an Adoption Subsidy Exist for this Child field, click on the appropriate 
radio button. 
If you click on the Yes radio button, the WMS Case ID and WMS CIN fields display. 

4 If you clicked on the Yes radio button in Step 3, record the WMS Case ID and WMS 
CIN directly in those respective fields. 

5 In the Address section, record the child’s new address information. 
 

—OR— 
 

Click on the Use Existing button to use the address information displayed in the 
Legally Freed Child Information section. 
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6 If you recorded an address in Step 5, click on the Validate button, then accept the 
validated address, if appropriate. (See the tip box on page 25.) 

7 Click on the Save button. 
The following message displays: 
“Child has been finalized for adoption. Person ID=<XXXXXXXX>. Family Services 
Stage should be closed immediately.” 

8 Click on the OK button. 

9 Click on the Cancel button to close the Finalize Adoption window. 
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Module 2: 
Case Maintenance 

In order to maintain data integrity, you may need to make additions or modifications to case 
information. There are times when a worker may need to change a case name. An example of 
this would be if the mother for whom the FSS is named gets married or divorced and her last 
name changes as a result. Cases may also need to be merged if there are duplicate cases 
open in CONNECTIONS. Conversely, cases may need to be split if two different cases were 
merged into one. Sometimes stages are left open in the system when they should be closed. 
CONNECTIONS provides several Case Maintenance functions for these tasks. 

By the end of this module, you will be able to: 

• change a case name; 

• change a stage type; 

• modify Progress Notes; 

• add an addendum to a frozen note; 

• merge cases; 

• split cases; and 

• close a Family Services Stage. 

Page 76 CONNECTIONS Step-by-Step Guide  
Version 1 (10/11/2005) Data Maintenance for Family Services Stages 



 

Changing the Case Name 
New cases are named after the first Principal (usually the mother) who is added to the initial 
report (CPS Intake) or the Family Services Intake. Each stage (e.g., FSI or FSS) of a case also 
has a Stage Name. The Stage Name may or may not be the same as the Case Name, 
depending on information known at Intake, changes in family composition, or other variables. 

The individual authorized to change the Case Name is subject to local district policy and 
procedure. This task may not fall under the scope of the 
individual worker’s responsibilities. In order to perform the 
Change Case Name function, the worker must a have a role in 
the case.  

 You may occasionally need to change the Case Name. If you 
update a person’s name that is also used as the Case Name, 
or if the case has the wrong name, you need to change the 
Case Name. In the first instance, you must always change the 
person’s name before you change the Case Name. This name 
change affects the name of all the stages in that case. 

A case must be named for a 
person who is part of the  

stage composition. 

 

Step-by-Step: 
Changing the Case Name 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the stage that requires a Case Name 
change. 

3 Click on the Options menu and select Case (Stage) 
Name/CD. 
The Case (Stage) Name/CD window displays. 

4 Click on the drop-down arrow for the New Name 
field. 
A list displays of the Principals in the case. 

5 Click on the name you want to use to change the 
Case Name. 
You cannot record a name here; you must select a name from the drop-down list. 

 
NYC workers also use this 
window to correct or update 

Community District information 
in the CD field for the 

assignment of the stage. NYC 
stages cannot be progressed 

without the CD field completed. 

6 Click on the Save button. 
The Assigned Workload displays. The selected stage now reflects the new 
Case Name. 

7 Click on the Close button. 
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Changing a Stage Type 
There are times when one type of FSS stage may need to be changed to a different type. For 
example, an FSS may begin as an Out of Town Inquiry (OTI) and the worker subsequently 
determines that the family requires services. The stage might then be changed to an FSS/CWS 
to provide the worker with the ability to record any assessment and service planning 
information. Only the Case Manager can change an FSS stage type and only the following non-
child welfare stage types can be changed: 

• Out of Town Inquiry (OTI) 
• Court Ordered Investigation (COI) 

 • Interstate Compact for the Placement of Children 
(ICPC) FSS/CWS and FSS/CCR types 

can never be changed. • Advocates Preventive Only (ADVPO) (NYC only) 

These FSS types can be changed to any of the types listed or to the CWS type. A CCR type is 
initiated when a child is freed for adoption; therefore, no stage can ever be manually changed to 
CCR.  

FSS stages (except CCR and CWS) in agency A66 (NYC) can be changed to the ADVPO type. 
Only a Case Manager in A66 can change an ADVPO type to a CWS type. 

From the Case Summary window, the Case Manager selects the stage to be changed and 
clicks on the drop-down menu in the Stage Type field. S/he selects a new stage type from the 
resulting list and clicks on the Save button. This change does not need to be submitted for 
approval. When a stage is changed to a CWS type and saved, the FASP, Service Plan Review 
and Key Dates are enabled on the FSS window. After saving, the following Alert To-Do is sent 
to workers with a role in the FSS stage: 

“The stage type for FSS stage # <Stage ID 
has been changed from <Type> to <Type>.” 

A system-generated event with a status of COMP is recorded on the Event List stating: 

“FSS Stage ID <Stage ID> 
has had the type changed from <Type> to <Type>.” 

 

 

Step-by-Step: 
Changing an FSS Stage Type 

1 On the Family Services Stage window, click on the Case Summary tab. 
The Case Summary window displays. 

2 Select the stage you wish to change from the stage information grid. 

3 In the Stage Type field, click on the drop-down arrow and select the desired stage 
type from the resulting list. 
The drop-down arrow only displays for the Case Manager. The Save and Cancel 
buttons enable.  

4 Click on the Save button. 
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Modifying Progress Notes 
Progress Notes can only be modified while in “Draft” status. Once a note has been saved as 
“Final,” it can no longer be modified; only an addendum may be made. If the Type of contact is 
changed, CONNECTIONS clears all of the worker-recorded data, with the exception of the 
narrative. If the Method of Contact is modified, the system clears all data fields that are 
inconsistent with the newly selected method. 

In order to modify notes, a worker must be: 
• the Progress Note’s Author; or 
• the Progress Note’s Entered By person. 

If the author is identified as “Other,” only the Entered By person can modify notes. 

 

Step-by-Step: 
Modifying a Progress Note 

1 On the Progress Notes window, click on the note in “Draft” status to be modified. 

2 Click on the Edit Note button. 
The Progress Notes Detail window displays for the selected Progress Note. 

3 Make the necessary modifications. Once all of the required fields are recorded, click 
on the Save as Draft button. 
 

—OR— 
 

Click on the Save as Final button. 
The following message displays:  
“Changes have been saved.” 

4 Click on the OK button. 
The Progress Notes window displays. 
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Adding an Addendum to a Frozen Note 
To modify notes that are in “Final” status, addenda are necessary. Addenda can be added to 
notes in open stages. In addition, the Closed Stage Addendum function can be used to create a 
new note in a closed stage. (When recording a Closed Stage Addendum, the note must be 
saved as “Final.”) 

Addenda can be added by the Progress Note’s Author, by 
anyone in the Author’s unit hierarchy and by the Progress 
Note’s Entered By person. When the Author of a Progress 
Note is identified as “Other,” a new addendum may be added 
by the Progress Note’s Entered By person, the assigned 
worker and anyone in the Entered By person’s hierarchy. A 
person outside of the unit hierarchy cannot amend a Progress 
Note when the author is identified as “Other”; a new note must 
be created. 

 
Since supervisors cannot 

modify their workers’ notes, they 
use addenda to add information 
to or clarify a note completed by 

one of their workers. 

Addenda are added to the bottom of the narrative of the original note. A Progress Note can 
have multiple addenda as long as the stage remains open. The new text is time-stamped with 
the name and ID of the logged-on worker. All previously recorded text in notes and addenda are 
locked for edit while a new addendum is being created. Once the narrative recording has been 
started, the View Existing Notes, Copy Note and New Note buttons disable, while the Save 
as Final and Cancel buttons enable. Addenda may only be saved as “Final.” 

 

Step-by-Step: 
Recording an Addendum to a Progress Note 

1 On the Progress Notes window, click on a note in “Final” status. 

2 Click on the Options menu and select Add Addendum. 
The Progress Notes Detail window displays for the selected 
Progress Note. All existing fields and the narrative 
are locked for edit. 

 

3 Record text at the bottom of the existing narrative. 

4 Click on the Save as Final button to save the 
addendum. 
The following message displays: 
“Changes have been saved.” 

5 Click on the OK button. 
The Progress Notes window displays. Once an 
addendum has been added to a Progress Note, the Addendum column of the 
search grid is flagged with a “Y,” indicating an addendum exists for the note. For 
notes that do not have addenda, the column is flagged with an “N.” 

If you click on the Cancel 
button, the addendum is not 

added, and the time/date and 
name are not stamped on the 

existing Progress Note. 
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Case Merge/Split Functions 
The Case Merge/Split function allows you to merge two separate cases into one case, sharing 
the same CONNECTIONS Case ID, or to split a case that was previously merged. The Case 
Merge/Split window is accessed via the Case Summary window through the Assigned 
Workload. 

The individual authorized to perform the Case Merge/Split function is subject to local district 
policy and procedure. This task may not fall under the scope of the individual worker’s 
responsibilities. Voluntary Agency workers are not permitted to perform any case Merges or 
Case Splits. 

In order to perform Case Merges and Case Splits: 

• a worker must be assigned the MERGE/SPLIT Business Function and: 
 have a role in the case; or 
 have an implied role in the case; or 
 be assigned the ACCESS ALL IN DISTRICT Business Function. 

 

—AND— 
• the case county must be the same as the worker’s county. 

If the above conditions are not met, the Case Merge/Split option on the Case Summary window 
is disabled. If a worker does not have the appropriate Business Function, s/he will be able to 
access the Case Merge/Split window in view-only mode.  

Merges and splits are pending until after the batch update is run overnight. At that time, a series 
of edits and checks are performed by CONNECTIONS to verify that the two cases can be 
merged or split.  

If a pending split fails the edit checks in the batch run, the worker needs to process the split 
again.  

You can identify whether a merge is still pending from the Merge/Split window or the Case List. 
“PF” indicates the Pending-From case and “PT” indicates the Pending-To case for merges that 
are pending batch update. After the batch update, the case that is Merged-From displays “MF” 
in the Merge column on the Case List; the case that is Merged-To displays “MT” in the same 
column.  

The Merge To Case is the case that will remain after the merge has taken place. The Merge 
From case is merged into the Merge To case and will have the attributes (such as the Case ID) 
of the Merge To case. Both Case IDs, when searched, point to the Merge To case. 

Specific rules exist regarding the merging of cases and stages in CONNECTIONS where FSI 
and/or FSS stages are involved. Keep in mind that “Open case” denotes that there is at least 
one open stage in a case and “Closed case” denotes that all stages in a case are closed. 

• The following cannot be merged: 
 FSI stages 
 FAD stages  
 FSS/CCR stages 
 CPS IABs 

• There must be at least one common Principal in the cases to be merged. 
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You cannot merge to or from any FSI stages, whether open or closed. Instead, FSIs can be 
“linked” to an open or closed CONNECTIONS case where the person who is or will be named 
as the Primary Caretaker is the same person in both cases. There must be at least one adult in 
common in two stages in order to link them. Linking is an immediate transaction, unlike merging, 
which requires an overnight batch. 

FSS Merge Rules 

Merge From Case Merge To Case Merge 
Allowed 

Merge Not 
Allowed 

Open FSS Open INT   

Open INT Open FSS   

Open FSS Closed INT   

Closed INT Open FSS   

Open FSS Open INV   

Open INV Open FSS   

Open FSS Open or closed INT, open or closed 
INV and open FSI   

Open or closed INT, open or closed 
INV and open FSI Open FSS   

Open FSS Open or closed INT, open or closed 
INV, closed FSI and open FSS  

 

Open or closed INT, open or closed 
INV, closed FSI and open FSS Open FSS  

(unless the 
open FSS 
exists in a 
different 
county or 

jurisdiction) 

Open FSS Closed INT, closed INV, closed FSI 
and closed FSS   

Closed INT, closed INV, closed FSI 
and closed FSS Open FSS   

Closed FSS  Any open or closed CPS stage  

 Any open or closed CPS stage Closed FSS  

 Closed FSS Closed FSS  

 Any open or closed IAB Any open or closed FSS  

 Any open or closed FSS Any open or closed IAB  
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Step-by-Step: 
Completing a Case Merge from the Assigned Workload 

1 Click on the WORK button. 
The Assigned Workload displays. 

 
2 Select the case to be Merged To. 

3 Click on the Options menu and select Case 
Summary. 
The Case Summary window displays. 

When merging cases, warnings 
and/or error messages may 

display. Warnings do not 
prevent you from completing a 
merge, but error messages do. 
Carefully review and consider 

both error messages and 
warnings before proceeding. 

4 Click on the Options menu on the Case Summary 
window and select Case Merge/Split.  
The Case Merge/Split window displays with the 
Merged Cases To section pre-filled.  

5 Enter the Case ID number for the case you wish to 
merge in the ID field of the Merged Cases From 
section. 

6 Click on the Validate button. 
The system checks to see if the merge is possible 
and may display error messages or warnings (See 
the tip box to the upper right). When the check is 
complete, the Merge button enables. 

 

There must be at least one 
Person ID in common with both 
cases/stages in order to perform 
the Case Merge/Split function. 7 Click on the Merge button. 

In the list at the top of the window, the merge 
displays with a red check mark in the Pending 
column. 

 

NOTE: If you realize that you have made a mistake 
in selecting your cases, click on the Cancel button 
and then click on the Yes button at the prompt 
asking if you wish to exit without saving. The Case 
Merge/Split window closes and the merge is 
canceled. 

If you determine that the case 
selected to be Merged From 

should, in fact, be Merged To, 
you must exit the Case 

Merge/Split window and begin 
the process again by selecting 

the other case. The Switch 
function is not available in the 

Case Merge/Split window. 

8 Click on the Save button. 
The Case Summary window displays. 

9 Click on the Close button. 
The Assigned Workload displays. 
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Step-by-Step: 
Completing a Case Split 

1 Click on the WORK button. 
The Assigned Workload displays. 

 2 Select the case to be split. 

3 Click on the Options menu and select Case 
Summary. 
The Case Summary window displays. 

4 Click on the Options menu on the Case Summary 
window and select Case Merge/Split. 
The Case Merge/Split window displays. 

5 From the list section at the top of the window, click 
on the Case Name that was merged in error. 
The merge information for the selected case displays in the detail section at the 
bottom of the window. 

When splitting cases, warnings 
and/or error messages may 

display. Warnings do not 
prevent you from completing a 
merge, but error messages do. 
Carefully review and consider 

both error messages and 
warnings before proceeding. 

6 Click on the Split button. 
A red check mark displays in the Pending column in the list section. 
NOTE: If you realize that you have made a mistake in selecting the case to be split, 
click on the Cancel button. The following message displays: 
“Do you want to cancel? Unsaved data and/or narrative(s) will be lost.” 
If you click on the Yes button in response to the message, the Case Merge/Split 
window closes and the split is cancelled. 

7 Click on the Save button. 
The Case Summary window displays. 

8 Click on the Close button. 
The Assigned Workload displays. 
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Stage Closure Process 

 
Only the Case Planner or the Case Manager may close a Family 
Services Stage (FSS). If the Case Planner or Case Manager is 
submitting an FSS/CWS or FSS/CCR for closure, 
CONNECTIONS determines whether a Plan Amendment with 
an “ending” or “discharge” type exists for this stage, or if there is 
a Family Assessment and Services Plan (FASP) for this stage 
currently in Pending status or approved within the last 30 days. 
If one of these criteria exists, the system proceeds with the 
stage closure. 

If the Case Planner initiates the 
stage closure, s/he submits it to 
his/her Unit Approver and Case 

Manager for approval. 

If the Case Planner or Case Manager is submitting an FSS/OTI, 
FSS/COI, FSS/ADVPO or FSS/ICPC stage for closure, the 
closure can be submitted without any further work or checks by the system. 

If the Case Manager initiates 
the stage closure, s/he submits 
it to his/her Unit Approver for 

approval.  

Closing an FSS stage also closes the corresponding case if the FSS is the only open stage in 
the case, other than an ARI stage. The case is not closed if there is an open FSI, FSS, CPS 
Intake or CPS Investigation. 

Plan Amendment Ending or Discharge types include the 
following: 

 • Preventive Services Ended 
• Child Discharged to Home, Relative or Other Caretaker You are not allowed to  

record Progress Notes for a 
stage when an approval for a 

stage closure is pending.  
You may only enter Progress 
Notes if you first invalidate the 

pending approval. 

• Adolescent Discharged to Independent Living 
• Child Discharged to Adult Residential Care 
• Child Discharged to Adoption 
• Child Returned Home from Non-LDSS Placement 
• Case Closed to CPS 

To close an FSS stage, the Case Planner or Case Manager 
selects the desired stage from the Stage Information grid on the 
Case Summary window and clicks on the drop-down arrow for 
the Reason Stage Closed field. The desired closure reason is 
then selected from the resulting list. S/he then clicks on the 
Submit button to submit the stage closure to the appropriate 
person(s) for approval.  

 
If there is no completed Plan 

Amendment, the Stage  
Closure Question window 

displays after clicking on the 
Submit button. You may then 
choose to complete the Plan 

Amendment by clicking on the 
Yes button (the Case 

Summary window displays) or 
proceed without completing a 
Plan Amendment by clicking 

on the No button. If you do not 
complete a Plan Amendment, 
comments are required in the 
Narrative field on the Stage 
Closure Question window. 

The Stage Closure Question Window 
In an FSS/CWS or FSS/CCR, if there is no Plan Amendment 
with an “ending or discharge” type, or there is no FASP currently 
in a Pending status or approved within the last 30 days, the 
Stage Closure Question window displays.  
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When first displayed, the Stage Closure Question window contains a yes/no question asking the 
Case Planner or Case Manager if s/he would like to stop the stage closure process and 
complete the Plan Amendment. S/he must indicate, by selecting either the Yes or the No 
button, whether s/he would like to complete a Plan Amendment or FASP prior to closing this 
stage. Clicking on the Yes button closes the window and the Case Summary window displays. 
After closing the Case Summary window, the Family Assessment and Service Plan tab may 
be selected and the required work can be completed. 

If the No button is selected, a Narrative field displays, directing the Case Planner or Case 
Manager to describe the level of achievement of outcomes essential to the child(ren)’s safety, 
permanency and well-being. This field holds a maximum of 3,000 characters and is required if 
the No button is selected. 

Once comments are recorded in the Narrative field, the OK button enables. Click on the OK 
button to allow the closure action to proceed. 

Closing an FSS stage also closes the corresponding case if the 
FSS is the only open stage in the case, other than an ARI 
stage. The case cannot be closed if there is an open FSI, FSS, 
CPS Intake or CPS Investigation; however, the FSS stage of 
that case may be closed. When closing the FSS would result in 
closing the case, the following message displays: 

 
The Stage Closure Question 
should only be used as an 

alternative to completing a Plan 
Amendment or FASP under 

specific circumstances. 
Refer to your supervisor 

regarding your agency’s policy. 

“Closing this stage will close the case. 
Do you wish to proceed?” 

• Clicking on the Yes button closes the FSS and the 
case. 

• Clicking on the No button cancels the closure action and displays the Case Summary 
window. 

When a FASP or Plan Amendment is required, workers must navigate to the FASP window. A 
Plan Amendment may be completed for any approved FASP type (i.e., Initial, Comprehensive or 
Reassessment) and is supported for both FSS/CWS and FSS/CCR stages. 
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Step-by-Step: 
Closing an FSS Stage  
by Completing a Plan Amendment 

1 On the Family Assessment and Service Plan window, click on the drop-down arrow 
for the Launch New FASP… field and select Plan Amendment from the resulting 
list. 

2 Click on the Launch button. 
If a FASP is available for launch and a worker chooses to launch the Plan 
Amendment, the following message displays, depending on the FASP type available 
(Comprehensive or Reassessment): “A FASP is available for launch. Are you closing 
the Family Services stage?” 

3 Click on the Yes button in response to the message.  
The Plan Amendment displays on the FASP tree. 

4 Click on the Plan Amendment node on the FASP tree. 
The Plan Amendment Maintenance window displays. “Update Service Plan” displays 
on the Selected Status Changes list. 

5 Highlight the desired status change(s) on the Status Changes list with an “ending” 
or “discharge” type; the choices are as follows: 

• Preventive Services Ended 
• Child Discharged to Home, Relative or Other Caretaker 
• Adolescent Discharged to Independent Living 
• Child Discharged to Adult Residential Care 
• Child Discharged to Adoption 
• Child Returned Home from Non-LDSS Placement 
• Case Closed to CPS 

6 Click on the >> (Add) button. 
The selected status changes are added to the Selected Status Changes list. 

7 If necessary, repeat Step 6 to add more status changes. Multiple statuses can be 
selected at once by holding down the Ctrl key while clicking with the mouse. 

8 Click on the Save button when you have added the desired status changes. 
The FASP window displays. 

9 On the FASP window, click each sub-node under the Plan Amendment node from 
the FASP tree; record and save the necessary information. 

10 Click on the Check FASP Detail button. 
The Check FASP Detail Component Status window displays. If there are any 
incomplete FASP components, they display on the window. If all FASP components 
are complete, the window is clear. 

11 If there are incomplete FASP components, click on the Close button and navigate to 
the component(s) to complete the required information.  
Once you complete the information, return to Step 9. 
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12 Once all FASP components are complete, click on the Submit button. 
The following message displays: 
“This action will close this window. Do you want to continue?” 

13 Click on the Yes button. 
The To-Do Detail window displays with the approver’s name in the Assigned To 
field; this field cannot be modified. 

14 Click on the Save button. 
If submitted by the Case Planner, the following message displays: 
”Approval To do created for Case Manager and Case Planner’s Unit Approver. Do 
you wish to add another approver?” 
 

—OR— 
 

If submitted by the Case Manager, the following message displays: 
“Case Manager submitted this approval. Approval To-Do created for Case Manager’s 
Unit Approver. Do you wish to add another approver?” 

15 Click on the No button. 
The Assigned Workload displays. 

16 Select the appropriate FSS stage and click on the Tasks… button. 
The Family Services Stage window displays. 

17 Click on the Case Summary tab. 
The Case Summary window displays. 

18 Select the FSS stage you wish to close from the stage information grid. 

19 Click on the drop-down arrow for the Reason Stage Closed field and select from the 
resulting list. 

20 Click on the Submit button. 
If the FSS is the only open stage in the case, the following message displays:  
“Closing this stage will close the case. Do you wish to continue?” 

21 Click on the Yes button. 
The following message displays:  
“This action will close this window. Do you want to continue?” 

22 Click on the Yes button. 
The To-Do Detail window displays with the name of the appropriate Approver. 

23 Click on the Save button. 
If submitted by a worker who is not the Case Manager, the following message 
displays:  
“Approval To-Do created for Case Manager and Case Planner’s Unit Approver. Do 
you wish to add another approver?” 
 

If submitted by the Case Manager, the following message displays: 
“Case Manager submitted this approval. Approval To-Do created for Case Manager’s 
Unit Approver. Do you wish to add another approver?” 
 

Click on the Yes button to complete a Staff Search to add another approver. 
 

—OR— 
 

Click on the No button to return to the Assigned Workload. 
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Stage Closure Approval Process 

 
Once all of the submission criteria are met, an Approval Task 
To-Do is created. The Case Planner saves this Task To-Do and 
the FSS stage is submitted to the Case Manager and the Case 
Planner’s supervisor/Unit Approver for review and approval. The 
Case Manager and supervisor/Unit Approver are both notified of 
the submission by a Task To-Do on the Staff To-Do List. The 
supervisor/Unit Approver can navigate from his/her Staff To-Do 
List to approve the stage closure by clicking on the Navigate… 
button. 

If someone other than the 
Case Manager or Unit 

Approver attempts to approve 
an FSS stage closure, the 

following message displays: 
“Case Manager/Supervisor 

Approval is needed.” 
The To-Do Detail window 
displays the appropriate 

person. 

If the FSS stage is the only stage in the case, when the 
supervisor/Unit Approver clicks on the Navigate… button, the 
following message displays: 

If the FSS stage being 
submitted for closure involves 
a child who is in the custody of 
OCFS and has been placed in 
a Voluntary Agency, the Case 
Planner’s submission is first 

directed to the Division of 
Rehabilitative Services (DRS) 
worker assigned to the stage, 
then to the Case Manager of 

the FSS. 

“Closing of stage will close the case – do you wish to continue?” 

To proceed with the case and stage closure, the supervisor/Unit 
Approver clicks on the Yes button, after which the Case 
Summary window displays. The Case Summary window 
displays immediately upon clicking on the Navigate… button if 
the case has other open stages. 

If this FSS stage was one in which the Stage Closure Question 
was required and answered, the following message displays, 
along with the Case Summary window: 

“The Closure Question has been answered.” 

 
The supervisor/Unit Approver clicks on the OK button to close 
the message and reviews the information recorded on the 
Case Summary window. After reviewing the closure 
information, s/he cancels out of the Case Summary window 
and the Approval Status window displays. Here the 
supervisor/Unit Approver selects his/her name and clicks on 
the Approve button. The following message displays: 

If there is a Pending FASP, it 
must be approved before the 

stage closure can be 
approved. 

The following message 
displays if a supervisor clicks 
on the Approve button when 

there is a Pending FASP: 
”Pending FASP must be 

approved first.” 

“Approval completion will freeze Events.  
Do you wish to add another approver?” 

If no other approver is needed, the supervisor/Unit Approver 
clicks on the No button and then the Save button on the 
Approval Status window.  

The Case Manager follows the same steps to approve the 
FSS. The Case Manager can only approve the FSS after the 
supervisor/Unit Approver (and any other approvers) has 
completed the approval process.  

Once the approval is complete, the following Alert To-Do 
displays on the Case Planner’s Staff To-Do List: 

“Approval Complete! Events have been frozen.” 

The supervisor must click on 
the OK button to close the 

message and return to his/her 
Staff To-Do List, where s/he 
can select the Approval Task 
To-Do for the Pending FASP. 
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CONNECTIONS notifies WMS that the FSS stage is closed; WMS updates the codes to reflect 
the stage closure. Although the WMS codes are updated, the worker must also close the case 
in WMS separately (see “Closing a WMS Case“ on page 116 for more information). 
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Module 3: 
Service Plan Review 

Service Plan Reviews provide an important opportunity for workers, families and service 
providers to meet and discuss progress, problems and the changing needs of a family. They 
also provide the district and agency with an important Quality Assurance tool: a Third Party 
Reviewer must be present to review the family’s progress and to determine whether the 
proposed plan will meet the family’s needs and achieve the permanency goal. 

By the end of this module, you will be able to: 

• access the Service Plan Review window; 

• add and modify outside participants; 

• schedule a Service Plan Review in CONNECTIONS; 

• add and notify invitees; 

• record attendance; and 

• record an SPR summary. 
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Once a Service Plan has been implemented for a family, 
periodic reviews are conducted to verify that changing 
circumstances are being considered and progress is being made 
toward the Service Plan goals. The Service Plan Review (SPR) 
functionality in CONNECTIONS is a scheduling, notification and 
documentation tool that helps organize the necessary activities 
and includes the participants who will attend the SPR. This 
might include scheduling meetings, using alerts to notify 
attendees and generating the appropriate letters. The same 
FASP can have multiple Service Plan Reviews. 

Further information about 
Service Plan Review 

functionality is available in the 
CONNECTIONS Case 

Management Step-by-Step 
Guide. 

Accessing the Service Plan Review Window 
The Service Plan Review is not part of the Family Assessment and Service Plan (FASP). There 
are several paths a worker can take to access the SPR, depending on his/her role in the stage 
and assigned Business Functions. 

The following individuals can create and modify Service Plan Reviews: 
• An assigned worker who has a role in the FSS 
• Any worker with modify access to the Assigned Workload of a worker with a role  

in the stage 
• Any worker who is in the assigned worker’s hierarchy 
• Any worker with the ACC SERPLAN REV Business Function (e.g., clerical staff, Third 

Party Reviewer) 

If you have a role in the stage or are in the assigned worker’s unit hierarchy, you can access the 
Service Plan Review from the Assigned Workload. If you are accessing the stage after it has 
been closed or you have been assigned the ACC SERPLAN REV Business Function (e.g., 
clerical staff or Third Party Reviewer), access the Service Plan Review using a Case Search. 

 

Step-by-Step: 
Accessing the Service Plan Review Window from the  
Assigned Workload 

1 On the Assigned Workload, click on the FSS stage for which you need to record a 
Service Plan Review. 
The Tasks… button enables. 

2 Click on the Tasks… button. 
The Family Services Stage displays. 

3 On the FSS window, click on the Service Plan Review tab. 
The Service Plan Review window displays.  
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Step-by-Step: 
Accessing the Service Plan Review Window via a Case Search  

1 Click on the CASE button on the CONNECTIONS Toolbar. 
The Case Search Criteria window displays. 

2 Enter the 8-digit Stage ID number into the Stage ID field (or the 8-digit Case ID 
number into the Case ID field). 

3 Click on the Search button. 
The Case List displays with the one case that matches the search criteria. 

4 Click on the case to select it from the Case List.  

5 Click on the Summary button. 
The Case Summary window displays with a list of all stages in the selected case. 

6 Click on the Family Services Stage to select it from the list. 

7 Click on the Options menu and select the Service Plan Review… command. 
The Service Plan Review window displays.  

 

Step-by-Step: 
Accessing the Service Plan Review Window from the Event List 

1 Click on the CASE button on the CONNECTIONS Toolbar. 
The Case Search Criteria window displays. 

2 Enter the 8-digit Case ID number into the Case ID field (or the 8-digit Stage ID 
number into the Stage ID field). 

3 Click on the Search button. 
The Case List displays with one case that matches the search criteria. 

4 Click on a case to select it from the Case List. 

5 Click on the Events button. 
The Event List displays for the selected case. 

6 Click on the Family Services Stage Opened event to select it from the Event List. 

7 Click on the Detail… button. 
The FSS window displays.  

8 Click on the Service Plan Review tab. 
The Service Plan Review window opens in view-only mode. 
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The Service Plan Review Window 
There may be several FASPs for a stage. Clicking on the Service Plan Review tab displays the 
Service Plan Review window, which contains an index of all FASPs in the stage. Although the 
SPR isn’t considered part of the FASP, it is FASP-specific. For this reason, the worker must 
select the desired FASP to view or maintain information regarding the SPR. Any FASP due 
within the next six months is listed here, as well as historical FASP information. Selecting a 
FASP brings forward any associated SPRs. At this point, you can opt to modify information for 
an existing SPR or record a new one.  

 

The Service Plan Review window displays a header with Case Name and Case Initiation Date 
fields. These fields are system-filled and cannot be modified. 

Two sections display below the header: 
• Select FASP 
• SPR Activity for Selected FASP 

The Select FASP section lists (in view-only mode) all of the FASPs associated with the stage. 
They are listed in descending order by FASP Due Date, with the most current FASP at the top. 
This section contains four columns: 

FASP Type • Initial 
• Comprehensive 
• Reassessment 

(for FSS/CCR stages, this is the only FASP Type) 

FASP Due Date  Date the FASP is due 
FASP Status  In-Process, Pending, Approved, Not Launched 
SPR Activity  The number of SPRs associated with the FASP 

The SPR Activity for Selected FASP section has the following three column headings: 

Date Scheduled Date the SPR is scheduled to take place 
Date Held Date the SPR was held 
Date Last Modified A date that is system-generated each time any component 

of the SPR is updated 
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The Service Plan Review Details Window 
The Service Plan Review Details window displays SPR activity information related to the 
selected FASP. This window contains a header, four tabs and a footer. In addition to the File, 
Options and Help menus, this window displays a Notification menu. The header contains the 
following system-populated fields, which display regardless of which tab is active: Case Name, 
Case Initiation Date and Case ID. 

 
Below the header, the following tabs display: 

Persons Workers use this tab to designate invitees to the Service 
Plan Review and to record attendance after the SPR is held. 
This may include assigned workers as well as outside 
participants. 

Workers use this tab to record the SPR time, date, location 
and contact information. 

SPR Scheduling 

On this tab, workers record a narrative including the family’s 
input, involvement and view; input from any others who were 
present, including foster parents; and a summary of the 
decisions reached. 

SPR Summary 

Third Party 
Reviewer 

This tab captures Third Party Reviewer comments on the 
process and content of the plan. 
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Step-by-Step: 
Opening the Service Plan Review Details Window 

1 On the Service Plan Review window, select the 
appropriate FASP (with SPR activity) from the 
Select FASP section. 
The SPR Activity for Selected FASP section 
populates with the SPR activity for that FASP. 

2 Select the SPR activity. 
The SPR Details button enables. 

3 Click on the SPR Details button. 
The Service Plan Review Details window displays. 

 

 

 

 

 
If there is a zero (“0”) in the 
SPR Activity field, double-

clicking the FASP row navigates 
directly to the Service Plan 

Review Details window.  

CONNECTIONS Step-by-Step Guide Page 97 
Data Maintenance for Family Services Stages  Version 1 (10/11/2005) 



Adding Outside Participants 
When planning a Service Plan Review, workers select the individuals who should take part in 
the review meetings. At times, these individuals are not involved in the stage and therefore are 
not part of the Stage Composition. This includes extended family, Law Guardians and service 
providers. The Add Outside Participants functionality allows these individuals to be added as 
participants in the SPR. 

The Outside Participants window can be accessed from the Service Plan Review Details 
window or the Visiting Plan window in the Foster Care Issues sub-node. Changes and/or 
additions made (and saved) to the Outside Participants window will display no matter which 
route is used to access the window. For example, a participant added to the window when it 
was accessed from the Service Plan Review Details window will also display when the Outside 
Participants window is accessed from the Visiting Plan window. 

 

The Outside Participants list displays at the top of this window. This is a list of any outside 
participants who have already been added to the stage through the Visitation functionality in the 
Foster Care Issues node. The columns displayed are Participant Name, SPR Role and 
Relationship. Once an individual is selected from the grid, all of the demographic information 
recorded for him/her is displayed in the fields below. These fields can be modified by selecting a 
row, editing the information that populates in the detail fields below the list and clicking on the 
Modify button. 

Below the list section, the following fields display in the detail section: 

Last Name  Record the last name of the Outside Participant in this required 
field. 

First Name  Record the first name of the Outside Participant in this required 
field. 

MI Record the middle initial of the Outside Participant in this field. 
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Record the individual’s role in the Service Plan Review by clicking 
on the drop-down arrow and selecting from the resulting list:  

SPR Role 

 • CASA Volunteer • Pre-adoptive Parent 
• Caseworker • Probation 
• Foster Child • Relative 
• Foster Parent • School Personnel 
• Guardian • Service Provider 
• Law Guardian • Third Party Reviewer 
• Other • Tribal Representative 
• Other District/Agency 

Staff 
• Qualified Expert 

Witness 
• Parent/Guardian 

Attorney 
This field is disabled when the window is accessed from the 
Service Plan Review Details window. 

Relationship 

Record the individual’s agency, if applicable. Agency 

The Participant Address section contains the following fields, 
along with a Validate button: 

 
• Street 
• PO Box/Apt. # 
• City All required fields highlight in 

yellow until information is 
recorded. The Add button 
enables only after required 

fields are completed. 

• State 
• Zip 

The following additional contact information fields display: 
• Phone All address information must 

be run though address 
validation by clicking on the 

Validate button. 

• Fax 
• Email 

The footer contains seven buttons: 

Add Adds new participant information to the 
Outside Participants list 

 
Modify Modifies previously recorded information 

for outside participants 
If an outside Third Party 

Reviewer (someone from 
outside your agency) is used, 
you must add this individual to 
the Outside Participants grid. 

Delete Deletes previously recorded participants 
from the list 

Clear Clears all fields and previous row 
selections on the list 

Save Saves the records to the Outside 
Participants list 
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Cancel Clicking the Cancel button discards any unsaved data. The following 
message displays: 

“Do you want to cancel? 
Unsaved data and/or narrative(s) will be lost.” 
• Click on the Yes button to discard the unsaved changes. 
•  Click on the No button to leave the tab open without discarding 

the unsaved changes 

Close Closes the Outside Participants window and displays the Persons tab. If 
you have not saved all of your changes prior to clicking on the Close 
button, the following message displays: 

“Do you want to exit? 
Unsaved data and/or narrative(s) will be lost.” 
• Click on the Yes button to discard the unsaved changes and close 

the Outside Participants window. 
•  Click on the No button to remain on the Outside Participants 

window; unsaved changes remain pending. 

 

Step-by-Step: 
Adding an Outside Participant to the Service Plan Review 

1 On the Service Plan Review Detail window, click on the Add Outside Participants 
button. 
The Outside Participants window displays. Any outside participants who were 
previously added to the stage display in the list section. Required fields highlight in 
yellow. 

2 Record the person’s name in the Last Name and First Name fields. 

3 In the SPR Role field, select the individual’s role using the drop-down arrow. 

4 In the Agency field, type in the name of the individual’s agency, if applicable. 

5 In the Participant Address section, record the individual’s address in the appropriate 
fields.  

6 When you have recorded the address, click on the Validate button. 
The address validation window displays. See the tip box on page 25 for information 
on the address validation process in CONNECTIONS. 

7 If the resulting address is correct, click on the Accept button to accept it. 
 

—OR— 
 

If the address is not correct, click on the Reject button and repeat Steps 5 and 6. 

8 Record phone, fax and e-mail information in the respective fields. 

9 When you are finished recording information for this person, click on the Add button. 
The information is added to the Outside Participants list. 
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10 Click on the Save button. 

11 Click on the Close button. 
The Persons tab displays. The Outside Participants field now displays the name of 
the individual you just added. 

 

Step-by-Step: 
Modifying an Outside Participant for the Service Plan Review 

1 On the Service Plan Review Detail window, click on the Add Outside Participants 
button. 
The Outside Participants window displays. Any outside participants who were 
previously added to the stage display in the list section. Required fields highlight in 
yellow. 

2 Select the person you wish to modify from the Outside Participants list. 
The selected person’s information populates the data fields. 

3 Make any necessary changes in the respective fields. 

4 When you have finished recording information for this individual, click on the Modify 
button. 

5 Click on the Save button. 

6 Click on the Close button. 
The Service Plan Review Details window displays with the Persons tab active.  
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The SPR Scheduling Tab 
Before any invitees can be notified about a Service Plan Review, the meeting needs to be 
scheduled. Workers use the SPR Scheduling tab to record the time, date, location and contact 
information for the SPR. If an SPR was previously scheduled, the details of the meeting are pre-
populated by the system using the most recently recorded information; this information can be 
modified by the worker. If no SPRs were recorded for this stage, all fields are clear. This 
information is used to generate alerts and letters from the Persons tab.  

 
The SPR Scheduling tab is comprised of the Location of Conference section, which contains 
the following fields: 

Record the date of the SPR. Date Review Scheduled 
Record the time of the SPR, specifying AM or PM.  Meeting Time 
Record the name of the contact person for the SPR. Contact Person 
Record the phone number for the SPR contact person. Contact Phone 
Record the location of the SPR. Location Name 
The room number of the SPR is optional. Room Number 
The floor number of the SPR is optional.  Floor Number 

The following fields display in the Address Information section: 

Record the street address for the SPR location. Street 
Any PO Box or apartment information for the SPR is 
optional. 

PO Box/Apt 

Record the city in which the SPR will take place. City 
The drop-down list displays all 50 states and defaults to 
“New York.” 

State 

Record the ZIP Code. Zip 
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Step-by-Step: 
Completing the SPR Scheduling Tab  

1 On the Service Plan Review Details window, click on the SPR Scheduling tab.  

2 In the Date Review Scheduled field, click on the check box for the current date to 
accept that date. 
To select a different date, click on the drop-down 
arrow and select a different date from the resulting 
calendar.  

 
3 In the Meeting Time field, record the time of the 

meeting. 
The meeting time must be 

recorded with four numbers and 
specifying AM or PM. 

4 In the Contact Person field, record the name of the 
contact person for the SPR. For example, 8:00am must be 

recorded as: 
5 In the Contact Phone field, record the telephone 

number for the contact person. 08:00AM 

6 In the Location Name field, record the location of the SPR. 

7 In the Room Number field, record the room number where the SPR will take place 
(if applicable). 

8 In the Floor Number field, record the floor number where the SPR will take place (if 
applicable). 

9 In the Street field, record the street address for the SPR location. 
Any additional address information (such as an apartment number) can be recorded 
in the PO Box/Apt field. 

10 In the City, State and Zip fields, record the city, 
state and ZIP Code for the SPR location. 
The State field defaults to “New York”; if necessary, 
click on the drop-down arrow to select from a list of 
all states. 

 

The information in the 
following fields defaults to the 

information saved from the last 
Service Plan Review recorded 

in CONNECTIONS: 

11 Click on the Validate button to validate the address 
information.  
The address validation window displays. 

12 If the resulting address is correct, click on the 
Accept button to accept it. 
 

—OR— 
 

If the address is not correct, click on the Reject 
button and repeat Steps 9 through 11. 

 • Contact Person 
 • Contact Phone 
 • Location Name 
 • Room Number 
 • Floor Number 
 • Street 13 Click on the Save button. 
 • City 

14 Click on another tab.  
 

—OR— 
 

Click on the Close button. 
The Service Plan Review window displays. 

 • State 
 • Zip 
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The Service Plan Review Invitees Grid 
As a worker determines who should be invited to the Service Plan Review, s/he adds them to 
the Service Plan Review Invitees grid on the Persons tab. Each time a worker clicks on the 
Add to Invitees button in any grid on the tab, the individual selected displays on the Service 
Plan Review Invitees grid. In this section, workers can record who attended the meeting, as well 
as any reason for non-attendance. Workers can also record the method by which the person 
was notified of the SPR and the date that the person was notified. 

The grid contains the following fields: 

The invitee’s name; not modifiable from this grid Person Name 

The invitee’s role, as determined in the list from which s/he was 
added (e.g., Third Party Reviewer, Guardian) 

Role  

A check box to indicate children age ten and older who have a 
Program Choice of “Placement”; not modifiable from this grid 

FC  

The method by which the individual was notified of the SPR (e.g., 
letter, alert, phone call)  

Notification 
Method 

The date the individual was notified of the SPR meeting Notification Date  

A check box to indicate whether an invitee attended the meeting Attended 

A comments field to record the reason for non-attendance at the 
SPR 

Reason for Non-
Attendance  

Notifying Invitees 
Once a worker adds the desired invitees to the Service Plan Review Invitees grid and records 
Service Plan Review scheduling information, s/he must notify them of the date, time and 
location of the review. This can be done through a system-generated Alert To-Do, a system-
generated letter or in non-system ways described below. 

 

Step-by-Step: 
Adding an Invitee  

1 If there is no existing Service Plan Review, select 
the desired FASP from the list and click on the New 
button on the Service Plan Review window. 
 

—OR— 
 

If you are modifying an existing Service Plan 
Review, select the desired FASP and Service Plan 
Review and click on the SPR Details button. 
The Service Plan Review Details window displays; 
the Persons tab is active. 

 

2 Click on the individual(s) you wish to invite to the 
SPR by highlighting the row(s) in the Stage 
Composition, Workers and/or Outside Participants grids. 

Multiple rows can be selected at 
once by holding down the Shift 
key while clicking on the desired 
rows (to select adjacent rows) 

or by holding down the Ctrl key 
while clicking with the mouse 

(to select adjacent or non-
adjacent rows).  
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3 Click on the Add to Invitees button below the corresponding grid. 
The selected individuals now display on the Service Plan Review Invitees grid.  

4 Click on the Save button. 

 

Step-by-Step: 
Notifying an Invitee via an Alert To-Do 

1 On the Persons tab, click on the Notification menu 
and select Generate Alerts. 
The following message displays: 
“Alerts have been generated for all workers invited 
to this Service Plan Review meeting.” 

 
Notifications can only be 

generated after the Service Plan 
Review has been scheduled. 

2 Click on the OK button. 
The Notification field in the Service Plan Review 
Invitees grid populates with “Alert”; the Notification 
Date field populates with today’s date. 

 

Step-by-Step: 
Notifying an Invitee via Letter 

1 Select an individual from the Service Plan Review Invitees grid. 
Only an individual who was added to the invitees grid from the Stage Composition 
grid or the Outside Participants grid can be selected to receive a letter. 

2 Click on the Notification menu and select Generate Letters. 
The Service Plan Review Notification Letter Report window displays. 

3 To print the letter, click on the Print ( ) icon. 
The Print window displays. Verify that the prompted printer choice is correct. 

4 Click on the OK button. 
The document is sent to the selected printer. 

5 To close the letter, click on the Close button. 
The Persons tab on the Service Plan Review Details window displays. The 
Notification field in the Service Plan Review Invitees grid populates with “Letter”; the 
Notification Date field populates with today’s date. 
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Recording SPR Attendance 
In addition to providing workers with a place to record the details of the SPR and notify invitees 
of the conference, the Service Plan Review functionality provides a method for recording 
attendance and reason(s) for non-attendance, when necessary. To record attendance, click on 
the Attended check box on the Service Plan Review Invitees list. If the invitee did not attend the 
conference, double-clicking the Reason for Non-Attendance field opens the Reason for Non-
Attendance window. Record a brief narrative of any known reasons for non-attendance (e.g., 
illness, scheduling conflicts) and also note instances when the invitee does not provide a 
reason. 

 
This comment window displays a narrative field that allows a maximum of 2,000 characters. The 
following buttons display below the narrative field: 

This button verifies the spelling of the text in the narrative and is 
disabled until a narrative is recorded. 

Spell Check 

This button closes the Reason for Non-Attendance window, returning 
you to the Persons tab. The OK button is disabled until you begin 
recording a narrative. The narrative is not saved until you click on the 
Save button on the Persons tab.  

OK 

Clicking on this button discards any unsaved data. The following 
message displays: 

Cancel 

“Do you want to exit? 
Unsaved data and/or narrative(s) will be lost.” 

• Click on the Yes button to discard the unsaved changes; the 
Persons tab displays. 

• Click on the No button to leave the comment window open 
without discarding the unsaved changes. 
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Step-by-Step: 
Recording SPR Attendance  

1 From the Service Plan Review Details window, select an individual from the Service 
Plan Review Invitees grid.  

2 Click to select the Attended check box to indicate that the selected individual 
attended the Service Plan Review. If s/he did not attend, double-click the Reason 
for Non-Attendance field and record a short narrative explaining the reason for non-
attendance. 

3 Click on the Save button. 

4 Click on another tab.  
 

—OR— 
 

Click on the Close button. 
The Service Plan Review window displays. 
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The SPR Summary Tab 
Narrative comments regarding the Service Plan Review are recorded on the SPR Summary tab 
in two separate fields: 

• The Family Input, Involvement and View field captures information regarding the 
family’s (and child’s, if appropriate) level of participation in the SPR and specific 
contributions that they made, as well as their perception of whether the Permanency 
Planning Goal is being met. 

• The Meeting Summary field captures special circumstances surrounding this SPR or 
the participating individuals, descriptions of the issues discussed, and the resolution. 

 

The SPR Summary tab displays a Date Review Held field above two narrative fields. If the 
stage is an FSS/CWS, the fields are titled Family’s Input, Involvement and View and Meeting 
Summary. If the stage is an FSS/CCR, the fields are titled Child’s Input, Involvement and 
View and Meeting Summary. These fields hold up to 4,000 characters. Each narrative is saved 
as final; multiple entries can be made in the fields.  

The following buttons display below the narrative fields: 
• Spell Check 
• Save 
• Cancel 
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Step-by-Step: 
Completing the SPR Summary Tab  

1 From the Service Plan Review Details window, click on the SPR Summary tab.  

2 In the Date Review Held field, click on the drop-down arrow and select from the 
resulting calendar the date when the review was held. 
This date can not be a future date. 

3 In the Family’s Input, Involvement, and View field, record a narrative detailing the 
family’s (or child’s if the stage is FSS/CCR) input, involvement and view. 

4 In the Meeting Summary field, record a narrative summarizing the meeting. 

5 Click on the Save button. 

6 Click on another tab. 
 

—OR— 
 

Click on the Close button. 
The Service Plan Review window displays. 
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Module 4: 
Interfaces 

With the implementation of Build 18, the concept of Interfaces is introduced to child welfare 
workers. An interface is the sharing of data between systems. With the implementation of the 
CONNECTIONS Case Management System, data from WMS and CCRS will be shared with 
CONNECTIONS.  

By the end of this module, you will be able to: 

• define the concept of Interfaces; and 

• describe how modifying data in one system affects another. 
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Interfaces 
With the implementation of the CONNECTIONS Case Management System, CONNECTIONS 
begins sharing information with two Legacy systems: the Welfare Management System (WMS) 
and the Child Care Review Service (CCRS). These two Legacy systems remain as the systems 
of record for Child Welfare Services cases, until full implementation with Build 19. Application 
Registration and maintenance for Child Welfare Services cases is conducted in 
CONNECTIONS; the WMS initiation of Application Registration is disabled for Child Welfare 
Services cases. 

The CONNECTIONS interface is an on-going process. This 
differs from Conversion, which brings the data into 
CONNECTIONS as a one-time-only process. The interface with 
WMS serves to minimize duplicative data entry when Family 
Services Stages (FSS) are created. The duplication of data 
recording is reduced (i.e., the recording of demographics and 
routine case data on multiple systems); this automated interface 
with WMS can eliminate some manual steps to open cases and 
keep some data synchronized between the systems. 

 
See the CONNECTIONS Build 

18 Interfaces Job Aid for 
detailed information  

about Interfaces. 

WMS Interface Overview 
Demographic information in WMS and CONNECTIONS is kept “in-synch” through an ongoing 
interface. After WMS case initiation (Application Registration) in CONNECTIONS, the balance 
of activities to open a case in WMS must be completed and services must continue to be 
authorized in WMS until Build 19. These activities encompass Full Data Entry (FDE) and include 
establishing a Client Identification Number (CIN), Case Number assignment, and authorizing 
Direct Services and Purchase of Services (POS), as well as necessary reauthorizations. The 
Local District is to follow local procedures for obtaining a new Services Case Number or “reuse” 
an existing Services Case Number for the WMS opening. 

The CONNECTIONS/WMS Interface is only available for FSS/CWS, FSS/CCR and 
FSS/ADVPO stages. New Family Services Stages (FSS) in CONNECTIONS are linked to a 
Case Number in WMS. The Interface links the individuals in those stages to CINs in the 
corresponding WMS case.  
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Maintaining Demographic Information in CONNECTIONS 
Demographic information recorded and saved in CONNECTIONS automatically transfers to 
WMS during the online interface process. The interface allows basic demographic information 
about individuals listed on the Stage Composition tab to be compared for a match in WMS. 
Demographics can only be recorded and modified in 
CONNECTIONS. Updates to shared fields are restricted from 
being modified in WMS, if that WMS Services Case is 
recognized as being linked to a CONNECTIONS case.  
For an App Reg, the first person entered in CONNECTIONS 
either from the SCR CPS Intake stage or in the Family Services 
Intake is sent to WMS as the Line 01 (“Applicant/Payee”) in 
WMS. The Line 01 person’s name and address become the 
Case Name and Address. 

Refer to the table in Appendix A 
for how information is 

maintained in WMS for 
Implemented agencies. 

Once entered in CONNECTIONS, the line order cannot be changed. In WMS, the 
Applicant/Payee can be assigned to any line number; however, it is customary for the Line 01 
person to be the Applicant/Payee. 

The order of the stage members on the CONNECTIONS FSS Stage Composition tab does not 
necessarily reflect the line order in WMS. 

1. The Mother, and/or anyone who may be a mother as selected in the Person Detail 
window sorted by the oldest person first 
(i.e., sex is Female  
-or-  
the Relationship is Parent, Parent Substitute, or Guardian) 

2. Principals (based on the person Type of Principal-PRN)  
(i.e., children; sorted by youngest to oldest) 

3. Collaterals (based on person Type of Collateral-COL or No Role) sorted by the oldest 
person first 

The hierarchy of information continues to exist between WMS 
Services and Non-Services records; data does not change in 
WMS Services if it does not agree with information in Non-
Services cases (e.g., Temporary Assistance, Medicaid 
Assistance, Food Stamps). If there is an existing Non-Services 
and Services case associated with the FSS, data can be 
modified and subsequently updated in CONNECTIONS but it 
will not be in-synch with WMS; the WMS Synch button remains 
enabled until differences are reconciled. The Services worker 
needs to contact the WMS Non-Services worker to determine 
which data is correct and the Non-Services worker must make the change in the WMS Non-
Services case, or the Services worker can reverse the change in CONNECTIONS. 

 
For ACS: 

The hierarchy exception does 
not apply, since WMS Non-

Services data is maintained in a 
separate database. 
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If any of the shared Application Registration fields are modified 
and then sent to WMS after Full Data Entry (FDE) has been 
started, but before the case has been fully opened by the batch 
update, the following occur:  

Full Data Entry (FDE) is 
comprised of the following 
activities that workers must 

complete: 

• The transaction to WMS is rejected. 
• The following error message displays: 

“WMS cannot be modified as Full Data Entry has 
begun. Please re-synch after the WMS Batch update.” 1. Establishing a Client 

Identification Number (CIN) • The WMS Synch button displays and enables. 
2. Case Number assignment 

The following fields cannot be modified in the WMS Services 
case:  

3. Authorizing Direct Services 
and Purchase of Services 
(POS), as well as necessary 
reauthorizations. 

• Case Fields • Date of Birth  
• Center (Agency)  • Worker  
• Office • Individual Fields 

(First and Last Names, 
Middle Initial, Sex, SSN, 
Suffix) 

 

• Unit • CIN 
(Once the CIN is 
passed from WMS to 
CONNECTIONS) 

If a worker modifies information in any of the CONNECTIONS 
fields listed above (with the exception of the CIN, which cannot 
be modified in CONNECTIONS) and clicks on the Save button 
on the Stage Composition tab on the FSS window, changes are sent automatically to WMS. If 
a Primary Caretaker is not identified (and the No Primary Caretaker Exists check box has not 
been selected) in the FSS stage, the following message displays: 

If the CIN in CONNECTIONS 
does not match the CIN in 

WMS, the number from WMS 
becomes the CIN.  

The CONNECTIONS CIN is 
end-dated and a new CIN is 
associated with the person in 

CONNECTIONS. 

“Unable to perform WMS synchronization, primary caretaker must be identified.” 

If a worker makes demographic changes in CONNECTIONS in any stage other than an FSS 
(e.g., an INV stage in which an individual is in common with the FSS), the WMS Synch button 
on the FSS Stage Composition tab enables. The WMS Synch button also enables if the Case 
Manager is reassigned. Clicking on this button or clicking on the Save button automatically 
generates a transaction to WMS to update the corresponding WMS fields. 

If there is an error, the message includes the WMS error number(s) encountered. If the case 
maintenance process with WMS Synchronization was not successful, the following message 
may display: 

“An error was encountered attempting to transmit this WMS Synch transaction to WMS.  
Please try again later.” 

Additional updates to any of the shared WMS/CONNECTIONS fields cannot be sent to WMS 
until the nightly batch returns a WMS Case number to CONNECTIONS. A system-generated 
Alert To-Do is sent to the Case Manager indicating any error number(s). 
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The WMS Button 
The Stage Composition tab collects all data last successfully transmitted to WMS. This data 
enables/disables the WMS App Reg/WMS Synch buttons (generically referred to as the ‘WMS 
button’). Differences between the information sent to WMS and the current WMS data trigger 
the button to enable. If no Application Registration has been initiated, the button is labeled WMS 
App Reg. Any time after that process initiates in WMS via the FSS window, the button is 
labeled WMS Synch. 
 

The button enables/displays 
under the following circumstances: 

The button does not enable/display under 
the following circumstances: 

WMS App Reg or Case and/or Full Data Entry 
has been completed. The WMS App Reg 
button does not display once a worker clicks on 
it to initiate Application Registration. The button 
never displays for Voluntary Agency workers. 

Displays as WMS App Reg only for Local 
District workers when there is no association to 
WMS and all App Reg required fields exist. This 
button only enables when a Primary Caretaker 
is selected in the FSS.  

The information last updated that synchronized 
WMS and CONNECTIONS has not been 
changed. 

Displays as WMS Synch for both Local District 
and Voluntary Agency workers when there is a 
difference between the current values of the 
shared fields. When a person is added to the Stage 

Composition tab, but not “related.” When a worker clicks on the button, a WMS 
transaction initiates. Upon successful 
transmission to WMS, the fields are updated 
and will be in-synch with current 
CONNECTIONS field values (e.g., person 
demographic information) once the nightly WMS 
batch processing is complete.  

When a person is added and related to the 
Stage Composition tab, but the Add Person 
window does not display during the relate (since 
all required demographic information was 
previously recorded). See Step 5 of “Relating a 
Person to a Family Services Stage” on page 24 
for more information. When a person is added and related to the 

Stage Composition tab, and the Add Person 
window displays during the relate (since all 
required demographic information was not 
previously recorded). See Step 5 of “Relating a 
Person to a Family Services Stage” on page 24 
for more information. 

Deletions of existing persons are completed in 
CONNECTIONS and will update in WMS 
immediately if WMS is in a “No Pend” status. 
Workers will also need to complete the WMS 
process in WMS (e.g., changing the goal status 
and POS updates). 

The WMS Synch button may enable when a 
person is added to the Stage Composition tab 
of an FSS; the information is updated in 
CONNECTIONS, however a CIN needs to be 
established in WMS via the normal WMS CIN 
process (Full Data Entry) and will then be 
updated in CONNECTIONS via a nightly batch 
process. 

The WMS Synch button will only enable when 
deletions of existing persons are completed in 
CONNECTIONS and WMS is awaiting a batch 
(status AT/FDE or AT/UM or UM/BUP). Workers 
must also complete the WMS process in WMS 
(e.g., changing the goal status and POS 
updates). 
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Clicking on the WMS Synch button or the Save button on the Stage Composition tab updates 
the WMS case. Any worker assigned to the stage can initiate synchronization by clicking on this 
button. Either Local District or Voluntary Agency workers can modify CONNECTIONS data. 
Individuals can also be added at this time; individuals added to Services cases may only be 
added in CONNECTIONS. All workers assigned to the case can add individuals to the FSS; 
however, those additions performed by Voluntary Agency workers cannot be sent to WMS. 
When the Voluntary Agency worker clicks on the WMS Synch button or the Save button on the 
Stage Composition tab, a Task To-Do is sent to the Case Manager; the transaction is not sent 
automatically to WMS. The task navigates the Case Manager to the FSS window, where s/he 
must review the addition and send a synch to WMS. When the Case Manager clicks on the 
WMS Synch button and any people were added to WMS, a 
Clearance Report is sent to his/her WMS printer. At this point in 
the process, it is up to the Local District worker to have the 
remainder of the WMS process completed (via Attachmate or a 
WMS terminal) to complete the CIN assignment, and 
subsequent completion of the WMS transaction, to the proper 
Pending status. The nightly batch update transmits CINs over 
from WMS to CONNECTIONS; this also deletes the Task To-
Do that originated with the Voluntary Agency worker. 

 

Stage Composition Tab (WMS case exists, changes detected) 

 

Attachmate is a system that 
allows a worker to access WMS 

directly from his/her 
CONNECTIONS computer. 
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End-dating Individuals 
Workers cannot delete individuals in WMS for cases linked to CONNECTIONS. Instead, 
deleting an individual is initiated from CONNECTIONS; a 
transaction is sent to WMS to delete the individual when an 
individual is end-dated in the FSS by selecting an applicable 
Reason Code. These conditions are identified from 
CONNECTIONS information to detect that a now-end-dated 
individual needs to be sent to WMS for deletion. This results in 
the changing of the status of the individual to DEL (Deleted) on 
the WMS case. 

 

End-dating the 
Payee/Applicant  
(Line 1 person): 

1 In WMS, select a different 
person to be the 
Applicant/Payee. 

If a Voluntary Agency worker end-dates an individual in 
CONNECTIONS, WMS is not updated until a Local District 
worker clicks on the WMS Synch button or makes a change to 
any individual demographics in the Stage Composition tab 
and clicks on the Save button, which sends the transaction to 
WMS. An Alert To-Do is sent to the Case Manager’s Staff To-
Do List notifying him/her that an individual has been end-dated 
or that there has been a change to demographic information. 
The Case Manager navigates to the FSS window and clicks on 
the WMS Synch button. 

2 After the nightly batch update, 
end-date the person in 
CONNECTIONS who was 
previously listed as the 
Applicant/Payee in WMS. 

3 Click on the WMS Synch 
button. 

Closing a WMS Case 

 

When the approval of an FSS closure linked to a WMS case is 
complete, WMS is updated to reflect the closing. If the FSS is 
linked to only an Application Registration, the application is 
withdrawn. Workers should not close a 

CONNECTIONS case when the 
corresponding WMS case has 

changes pending or is in 
error status.  

When the FSS closes, the worker also needs to close the 
corresponding WMS Services case in WMS; this is only 
allowed when the CONNECTIONS case is closed. There is no 
automatic closure of the WMS case when a CONNECTIONS 
case is closed; this allows for closing the WMS case at a later 
date, possibly pending an outstanding payment from a vendor 
on a Services case. The WMS case cannot be closed until the 
FSS is closed in CONNECTIONS. 

Workers should complete one of 
the following: 

a. Cancel the pending 
transaction and/or correct the 

error conditions.  
-OR- 

b. Allow the nightly batch 
process to update the pending 

transaction in WMS.  

Upon successful closing of the WMS case, a Services 
Authorization document is automatically sent to the WMS 
printer associated with the worker. CCRS-IND code Y on the 
Service Authorization LDSS 2970 form indicates that the case 
is known to CONNECTIONS and the CONNECTIONS case is 
closed. 

When the WMS case is in “No 
Pend” status, close the FSS 

case in CONNECTIONS. 
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Daily Batch Update 
The following WMS-CONNECTIONS update is executed daily to update CONNECTIONS cases 
with appropriate data from the WMS Services case: 

The CONNECTIONS FSS is updated with the 
newly created WMS case to which it is linked.  

Open (TX-TYPE = 02) Transactions 
on WMS cases known to 
CONNECTIONS The PIDs of all of the individuals in the 

CONNECTIONS FSS are updated with the 
appropriate WMS CINs. If the WMS CIN is different 
from the CONNECTIONS CIN, the 
CONNECTIONS CIN is end-dated and a new CIN 
is associated with the person in CONNECTIONS.  

Recertification transactions on WMS Services are 
updated to cases known to CONNECTIONS in 
which an individual has been added. 

Recertification (TX-TYPE = 06) 
Transactions 

The PIDs of all of the individuals in the 
CONNECTIONS FSS are updated with the 
appropriate WMS CINs assigned as a result of the 
WMS Clearance and the CIN assignment on WMS. 

Person demographic updates in WMS non-services 
cases will automatically update person 
demographic information in WMS services cases, 
and the corresponding person demographic 
information in CONNECTIONS will be updated via 
a nightly batch. An alert is sent to the Case 
Manager’s Staff To Do List notifying him/her about 
the change in CONNECTIONS data as a result of a 
change in WMS Non-Services data. 

Person Demographic Updates  

The PIDs linked to CINs updated via the Non-
Services case (with Services involvement) are 
updated in CONNECTIONS.  

The following fields are updated: 
Name, Sex, Date of Birth and SSN. 

A CIN that is assigned via the batch interface may 
not be changed through the Stage Composition 
tab on the Family Services Stage window or the 
Person Identifiers window. 
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Nightly Batch Update 
The following events are a part of the nightly batch update:  

These transactions are cases in which the App Reg was initiated in 
CONNECTIONS. The batch update closes the loop by updating the FSS 
with the assigned WMS Case Number, as well as with the all of the CINs 
assigned during the Full Data Entry process. 

Case Opening 
Transactions  

Recerts are cases in which a transaction, initiated from CONNECTIONS, 
added a person to WMS. The CIN (assigned or entered in WMS) of the 
newly added person is sent to CONNECTIONS. 

Recerts 
(Individuals 
added to 
WMS case)  

These are Services cases affected in the WMS batch update by a 
demographic change to an individual who also existed in a Non-Services 
case. The demographic change to the individual in a Non-Services case 
is modified in the Services case and is updated in CONNECTIONS via 
the nightly batch. 

Non-Services 
(Hierarchy) 

Remember, the hierarchy of information continues to exist between WMS 
Services and Non-Services records. Data does not change in WMS 
Services if it does not agree with information in Non-Services cases. If 
there are existing Non-Services and Services cases associated with the 
FSS, data can be modified in CONNECTIONS but it will not be in-synch 
with WMS. The Sync button will enable in CONNECTIONS and when 
clicked, a message will display indicating that the Non-Services worker 
needs to be contacted to make the appropriate change to the Non-
Services WMS case. The Services worker needs to contact the WMS 
Non-Services worker to determine which data is correct and the Non-
Services worker must make any appropriate change in the WMS Non-
Services cases. The Sync button no longer displays once the changes 
have been made in the WMS Non Services Case and CONNECTIONS is 
updated via the batch. 

When a CIN is unduplicated in WMS, the Services case in which it is 
involved appears on the WMS Daily Audit file. The unduplicated CIN is 
reflected in CONNECTIONS. 

CIN-UNDUP 
transactions 

Successful completion of these WMS screens displays an Authorization report including a case 
number and a pending status allowing for a WMS batch update. 
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Module 5: 
Support Tools 

When you’re using CONNECTIONS, you may have questions that are not answered in this 
guide. There is a wealth of additional information available to you that will help you answer 
these questions. 

By the end of this module, you will be able to: 

• access Online Help for assistance in accomplishing CONNECTIONS tasks; 

• contact the Help Desk to get basic trouble-shooting questions answered; and 

• access Job Aids and Step-by-Step Guides from the OCFS CONNECTIONS intranet site. 
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Online Help 
The CONNECTIONS Online Help feature provides descriptions for various windows, as well as 
step-by-step instructions for common tasks. You can access Online Help at any time, from any 
window in CONNECTIONS. There are different ways to access Online Help: you can click on 
the Help menu in CONNECTIONS or you can press the F1 key on your keyboard to access 
context-sensitive Online Help.  

The Contents, Index and Search tabs in Online Help allow you to search for and navigate to 
the topic(s) you need help on. 

Updates to Online Help content and functionality in CONNECTIONS are ongoing. As part of 
recent updates, new Online Help functionality has been added for Family Services Stage 
windows, as well as Child Protective Record Summary windows and Foster and Adoptive Home 
Record Summary windows. When you click on Help from any of those windows, the drop-down 
Help menu displays. For example, from the Progress Notes window, clicking on Help will 
display Progress Notes Help and from the Child Protective Record Summary window, clicking 
on Help will display CPRS Help. 

 

Step-by-Step: 
Accessing Online Help 

1 Click on the Help menu on the CONNECTIONS Toolbar. 
The following list of commands displays: 

A table of contents for the help facility with links to major sections. Contents 
Step-by-instructions to help you complete tasks using 
CONNECTIONS.  

How Do I? 

Descriptions of windows in CONNECTIONS, along with information on 
various fields. 

Window 
Descriptions 

Online OCFS policy handbooks (under revision). DSS Policy 
Window description help for the window you are on. Help On This 

Window 
Instructions on how to use the help functionality.  Help for Help 
Information about the current CONNECTIONS version and build. About 

CONNECTIONS 

2 Click on a command from the Help menu. 
The window related to your selection displays. In some cases, you will need to make 
another selection in that window to obtain instructions. At the top of each window, 
you’ll see additional buttons and menus. Use the Search button to search for 
specific information in the Help function and use the Back button to return to 
windows you’ve just visited in Help. The Glossary button opens a list of important 
CONNECTIONS terms and the Print button allows you to print Help information. 

3 When you’re done reviewing information in Help, close each Help window by clicking 
on the Close button ( ) in the top right corner of the window. 
The system returns to the window you were using when you accessed Help. 
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Enterprise Help Desk 
The New York State Office for Technology (NYS OFT) Enterprise Help Desk staff are available 
to answer basic questions related to your equipment, or to solve problems you’re having with 
the CONNECTIONS application. If they cannot solve your problem, they will record your 
information and forward it to others who can. 

Your agency may have procedures in place for contacting the Help Desk. Check with your 
supervisor before you call. 

The Help Desk is staffed 24 hours a day, seven days a week. The telephone number is: 

1-800-NYS-1323 
(1-800-697-1323) 

When you call the Help Desk with a problem, you will be given a ticket number to use for 
tracking your issue and its resolution. Keep a record of this number; you will need it for any 
follow-up conversations with the Help Desk. 
 

 
The CONNECTIONS Case Management Step-by-Step Guide 
(CD Version) 
The CONNECTIONS Case Management Step-by-Step Guide is 
offered in CD format, giving workers the ability to gain the 
fundamental skills and knowledge of the functionality of Build 
18 right at their own desks. The CD is a support tool for workers 
to use when they are not logged on to the CONNECTIONS 
system and includes all of the modules from the 
CONNECTIONS Case Management Step-by-Step Guide. The 
CD contains search functionality, allowing workers to access 
and search the modules using an index.  

 

For a copy of the CD, speak with your Implementation 
Coordinator. The CD is also distributed to participants attending the CONNECTIONS Case 
Management for CPS Workers and CONNECTIONS Case Management for Child Welfare 
Workers trainings. 

The CONNECTIONS Case 
Management Step-by-Step 
Guide is also posted on the 

OCFS CONNECTIONS  
intranet site. 
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OCFS CONNECTIONS Intranet Site 
A variety of training-related materials are available from the OCFS CONNECTIONS intranet site 
(http://ocfs.state.nyenet/connect/), as well as from the Public Folders in Microsoft Outlook. The 
intranet site and public folders contain a wealth of information related to various aspects of 
CONNECTIONS, including training schedules, Alerts and Notices, Step-by-Step Guides 
(including the CONNECTIONS Case Management Step-By-Step Guide), Job Aids and 
Frequently Asked Questions (FAQs). 

 

Step-by-Step: 
Accessing the OCFS CONNECTIONS Intranet Site 

1 Double-click the Internet Explorer icon. 
The NYS Department of Family Assistance  
home page displays. 

 2 Click on the OCFS link on the state map. 
The Office of Children and Family Services 
 home page displays. If the NYS Department of Family 

Assistance home page is not 
your default home page, enter 

http://ocfs.state.nyenet/connect/ 
in the address bar of the 

Internet Explorer window and 
press the Enter key on your 

keyboard, which will open the 
CONNECTIONS home page. 

3 Click on the CONNECTIONS link in the Intranet  
Programs and Services section 
on the left side. 
The CONNECTIONS home page displays. 

4 Click on a topic to access information. 

5 To close Internet Explorer, click on the File menu 
and select Close. 

CONNECTIONS Step-by-Step Guide Page 123 
Data Maintenance for Family Services Stages  Version 1 (10/11/2005) 

http://ocfs.state.nyenet/connect/




 

Appendix A: 
WMS Maintenance 

CONNECTIONS Step-by-Step Guide Page A1 
Data Maintenance for Family Services Stages  Version 1 (10/11/2005) 



Page A2 CONNECTIONS Step-by-Step Guide  
Version 1 (10/11/2005) Data Maintenance for Family Services Stages 



 

What you 
should do in 

CONNECTION
S 

Special 
Instructions 

What should 
happen in WMS 

What could happen 

Add people to 
cases 

Do not add a 
person to a 
case when 
records are 
pending in 
WMS 

Will display in 
WMS and the 
WMS case would 
be in “UM/CL” 
status.  

Fatal Error: LN24 Cannot add or delete person due to 
pending record.  

You cannot add a person to a WMS case when other 
pending records exist in WMS. If you need to perform 
multiple tasks on the same case, please ensure you 
add/delete people prior to changing demographics on 
other case members. 

Complete FDE 
for new person 
(including recert). 
After nightly 
batch 
processing, CIN 
will display in 
CONNECTIONS. 

End Date 
people from 
cases 

Do not delete 
a person 
from a case 
when records 
are pending 
in WMS. 

Will be deleted in 
WMS and WMS 
case would be in 
“A-SFED/M” 
status. Navigate 
to  the WMS DIR 
screen and enter 
the goal status 
for the deleted 
person if it 
applies. You 
must also 
complete a recert 
(06). Select only 
the WSUWK2, 
WSUDIR and 
WSUPOS (if 
needed) to 
perform the 
recert.  

Fatal Error: LN24 Cannot add or delete person due to 
pending record. 

You cannot end date a person in a WMS case when 
other pending records exist in WMS. If you need to 
perform multiple tasks on the same case, please 
ensure you add/delete people prior to changing 
demographics on other case members. 

Please note that after you delete a person, the name 
remains on the authorization for one time (looking as 
though you never made the change). The next time you 
generate an authorization, the name is no longer 
displays. 

Change Middle 
Initial 

Need to 
change, add 
or erase on 
the Stage 
Compositio
n tab; not in 
the Person 
Detail 
window. 

Will display in 
WMS and be in 
“AT/UM” status; 
after batch 
processing, will 
be in synch. 

Fatal Error: This individual is also active in a Non-
Services case. The Middle Name of this individual was 
changed and the change does not match the Middle 
Name on the data base.  
*FATAL* for Last name, Firstname (PID:99999999). 

The Case Manager will receive an alert; WMS synch 
will remain enabled until resolved by the Services/Non-
Services workers. 
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What you 
should do in 

CONNECTION
S 

Special 
Instructions 

What should 
happen in WMS 

What could happen 

Change Last 
Name 

Can be 
changed on 
the Stage 
Compositio
n tab; not in 
the Person 
Detail  
window. 

Will display in 
WMS and be in 
“AT/UM” status; 
after batch 
processing, will 
be in synch. 

Fatal Error: This individual is also active in a Non-
Services case. The Last Name of this individual was 
changed and the change does not match the Last 
Name on the data base.  
*FATAL* for Last name, Firstname (PID:99999999). 

The Case Manager will receive an alert; WMS synch 
will remain enabled until resolved by the Services/Non-
Services workers. 

Change First 
Name 

Can be 
changed on 
the Stage 
Compositio
n tab; not in 
the Person 
Detail 
window. 

Will display in 
WMS and be in 
“AT/UM” status; 
after batch 
processing, will 
be in synch. 

Fatal Error: This individual is also active in a Non-
Services case.  The First Name of this individual was 
changed and the change does not match the First 
Name on the data base.  
*FATAL* for Last name, Firstname (PID:99999999). 

The Case Manager will receive an alert; WMS synch 
will remain enabled until resolved by the Services/Non-
Services workers. 

Change Suffix 
(Jr, Sr.) 

Can be 
changed, 
added or 
deleted on 
the Stage 
Compositio
n tab; not in 
the Person 
Detail 
window. 

Will display in 
WMS and be in 
“AT/UM” status; 
after batch 
processing, will 
be in synch 

Fatal Error: This individual is also active in a Non-
Services case. The Last Name of this individual was 
changed and the change does not match the Last 
Name on the data base.  

*FATAL* for Last name, Firstname (PID:99999999). 
This is because Suffix is considered as part of last 
name in WMS. 

The Case Manager will receive an alert; WMS synch 
will remain enabled until resolved by the Services/Non-
Services workers. 

Change Date of 
Birth 

Can be 
changed, 
added on the 
Stage 
Compositio
n tab; not in 
the Person 
Detail 
window. 

Will display in 
WMS and be in 
“AT/UM” status; 
after batch 
processing, will 
be in synch 

Fatal Error: This individual is also active in a Non-
Services case.  The Date of Birth of this individual was 
changed and the change does not match the Date of 
Birth on the data base. The Case Manager will receive 
an alert; WMS synch will reamin enabled until resolved.
*FATAL* for Last name, Firstname (PID:99999999). 

 

Change Social 
Security number 

Can be 
changed, 
added on the 
Stage 
Compositio
n tab; not in 
the Person 
Detail 
window. 

Will show up in 
WMS and be in 
“AT/UM” status; 
after batch 
processing, will 
be in synch 

Fatal Error: This individual is also active in a Non-
Services case.  The SSN of this individual was changed 
and the change does not match the SSN on the data 
base.  
*FATAL* for Last name, Firstname (PID:99999999). 

The Case Manager will receive an alert; WMS synch 
will remain enabled until resolved. 
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What you 
should do in 

CONNECTION
S 

Special 
Instructions 

What should 
happen in WMS 

What could happen 

Change any 
demographic 
data or add or 
delete individual 

Do not 
change any 
demographic 
data or add 
or delete 
individual 
when the 
WMS case is 
in UM/BUP 
status. 

Change done in 
CONX will not be 
reflected in 
WMS. The WMS 
SYNCH button 
would be 
enabled. After 
the batch 
processing, click 
on the WMS 
SYNCH button 
so the pending 
data in CONX 
goes to WMS. 

LN24 – Transaction not allowed until batch 

Change Sex Can be 
changed, 
added on the 
Stage 
Compositio
n tab; not in 
the Person 
Detail 
window. 

If sex is changed 
for the 
Applicant/Payee, 
displays in WMS 
as “AT/UM” 
status; after 
batch 
processing, will 
be in synch. 

Change to the Applicant/Payee 
Fatal Error: This individual is also active in a Non-
Services case. The Sex of this individual was changed 
and the change does not match the sex on the data 
base (for the Applicant/Payee).  
*FATAL* for Last name, Firstname (PID:99999999). 

The Case Manager will receive an alert; WMS synch 
will remain enabled until resolved.  

Change to other stage members: 
Non-Fatal Error: Case status in WMS has changed to 
UM/ERR. This requires “zero maintenance;” the worker 
should make the necessary change in WMS and on 
successful completion, the case status changes to 
“AT/UM.” 

If the sex is 
changed for 
other stage 
members (NOT 
the 
Applicant/Payee)
, the case status 
changes to 
“UM/ERR” as the 
relationship code 
on the WSUWK2 
screen does not 
match the 
change. 

Change Case 
Name 

Change in 
CONX 

Must change in 
WMS, if FDE has 
been completed 
and successfully 
updated through 
WMS batch. 
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What you 
should do in 

CONNECTION
S 

Special 
Instructions 

What should 
happen in WMS 

What could happen 

Change 
addresses 

Change in 
CONX 

Must change 
Case Address in 
WMS if FDE has 
been completed 
and successfully 
updated through 
WMS batch; 
make sure this 
corresponds with 
the “payee 
address” in 
CONX. System 
will not auto 
synch any 
address. 

 

Change Primary 
Caretaker while 
in APP REG 
stage (prior to 
FDE) 

 Will change the 
case name in 
WMS 

 

Change 
Address on 
Primary 
Caretaker while 
in APP REG 
stage (prior to 
FDE) 

 Will change the 
case address in 
WMS. 
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